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サービスの再起動

サービスを停止しなければならない場合、これらのサービスは、Unified CCX 
Administration アプリケーションを使用して、任意の順番で再起動できます。

サービス名および実行可能ファイル

サービスが実行されているかどうかを確認するには、Unified CCX Administration コン

トロール センターを使用するか、または Microsoft Windows の [Services] コントロー

ル パネルを開きます。

表 15. サービス名および実行可能ファイル

[Services] コントロール パネル に表示されるサービス名 実行可能ファイル

Cisco Browser and IP Phone Agent Service IPPASvr.exe

Cisco Desktop Agent E-Mail Service EEMServer.exe

Cisco Desktop Call/Chat Service FCCServer.exe

Cisco Desktop Enterprise Service CTIStorageServer.exe

Cisco Desktop LDAP Monitor Service LDAPmonSvr.exe、
slapd.exe、
slurpd.exe

Cisco Desktop Licensing and Resource Manager 
Service

LRMServer.exe

Cisco Desktop Recording and Statistics Service FCRasSvr.exe

Cisco Desktop Recording Service RPServer.exe

Cisco Desktop Sync Service DirAccessSynSvr.exe

Cisco Desktop VoIP Monitor Service FCVoIPMonSvr.exe
39



Cisco CAD トラブルシューティング ガイド
ShowLicenseUsage ユーティリティ

（注）このユーティリティは完全にはテストされていません。現状のま

ま提供されています。

ShowLicenseUsage ユーティリティを実行すると、デスクトップ シートを消費してい

る、または Cisco Desktop Administrator や Cisco Workflow Administrator を実行して

いるクライアントの IP アドレスを表示できます。

IP Phone Agent および CAD-BE シートでは、IP アドレスはアクティブな Browser and 
IP Phone Agent（BIPPA; ブラウザおよび IP Phone エージェント）サービスの IP アドレ

スです。Web ベースの Cisco Desktop Administrator では、IP アドレスは CAD サーバ

の IP アドレスです。

ShowLicenseUsage.exe は、CAD サーバの C:¥Program Files¥Cisco¥Desktop¥bin 
フォルダから実行されます。

ShowLicenseUsage ユーティリティを使用するには次の手順を実行します。

1. CAD サービスをホスティングしているサーバで、Windows Explorer を開きま

す。

2. C:¥Program Files¥Cisco¥Desktop¥bin フォルダにナビゲートします。

3. ShowLicenseUsage.exe をダブルクリックして、ユーティリティを実行します。

コマンド ウィンドウが開き、結果が表示されます（図 1）。

図 1. ShowLicenseUsage ユーティリティの結果
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コマンド ウィンドウのエントリについては、表 16 で説明します。

表 16. ShowLicenseUsage の結果のヘッダー

結果のヘッダー 説明

admin - desktop このバージョンでは使用されません。

admin - enterprise Cisco Work Flow Administrator および Cisco 
Desktop Administrator のユーザをリストしま

す。

admin - personnel このバージョンでは使用されません。

admin - cti config このバージョンでは使用されません。

seat Cisco Agent Desktop、Cisco Agent Desktop
（Browser Edition）、Cisco IP Phone Agent、お

よび Cisco Supervisor Desktop のユーザをリス

トします。
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ディレクトリ サービス データベースの回復

破損したディレクトリ サービス データベース

ディレクトリ サービス データベースが破損した場合は、次の手順を実行します。

ディレクトリ サービス データベースを回復するには、次の手順を実行します（方法 1）。

1. データベースをホスティングしている PC で、LDAP モニタ サービスを停止しま

す。

2. コマンド ウィンドウを開きます。

3. ディレクトリを ...Cisco¥Desktop¥bin に変更します（このディレクトリのドラ

イブと正確な場所は、サービスがインストールされている場所によって異なりま

す）。

4. ...Cisco¥Desktop¥bin ディレクトリで、次のコマンドを入力します。

db_recover -h ../database -v

Enter キーを押します。

5. exit と入力し、Enter キーを押して、DOS ウィンドウを閉じます。

6. LDAP モニタ サービスを再起動します。

この手順で上手くいかない場合は、次の手順を実行してください。

ディレクトリ サービス データベースを回復するには、次の手順を実行します（方法 2）。

1. データベースをホスティングしている PC で、LDAP モニタ サービスを停止しま

す。

2. コマンド ウィンドウを開きます。

3. ディレクトリを ...Cisco¥Desktop¥bin に変更します（このディレクトリのドラ

イブと正確な場所は、サービスがインストールされている場所によって異なりま

す）。

4. ...Cisco¥Desktop¥bin ディレクトリで、次のコマンドを入力します。

slapcat -f slapd.conf -l backup.ldif -c

Enter キーを押します。

5. 既存のフォルダの名前を ...Cisco¥Desktop¥database から 
...Cisco¥Desktop¥old_database に変更します。

6. ...Cisco¥Desktop¥database という名前の新しいフォルダを作成します。

7. DB_CONFIG、および拡張子 *.dat を持つすべてのファイルを old_database 
フォルダから新しい database フォルダにコピーします。

8. database フォルダに、rep.log という名前の空のファイルを作成します。

9. コマンド ウィンドウを開きます。
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10. ディレクトリを ...Cisco¥Desktop¥bin に変更します（このディレクトリのドラ

イブと正確な場所は、サービスがインストールされている場所によって異なりま

す）。

11. ...Cisco¥Desktop¥bin ディレクトリで、次のコマンドを入力します。

slapadd -f slapd.conf -l backup.ldif -c

Enter キーを押します。

12. exit と入力し、Enter キーを押して、DOS ウィンドウを閉じます。

13. LDAP モニタ サービスを再起動します。

同期されていないディレクトリ サービス データベース

セカンダリ ディレクトリ サービス データベースとプライマリ ディレクトリ サービス 
データベースとの同期が失われることがあります。この原因の 1 つには、セカンダリ 
データベースが再インストールされたことが考えられます。

次の手順を実行して、2 つのデータベースを同期化します。

1. プライマリ データベースをホスティングしている PC で、LDAP モニタ サービ

スを停止します。

この時点で、セカンダリ LDAP はダウンしている可能性があります。

2. ...¥Cisco¥Desktop¥database フォルダにあるファイル repl.log および 
repl.log.lock の内容をすべて削除します。

3. ...¥Cisco¥Desktop¥run¥logs¥replica、...¥Cisco¥Desktop¥logs¥replica、お

よび ...¥Cisco¥Desktop¥logs¥ReplLogs フォルダに入っているファイルをすべ

て削除します。

4. プライマリ データベース コンピュータでコマンド ウィンドウを開きます。

5. フォルダを ...¥Cisco¥Desktop¥bin に変更します（このフォルダのドライブと

正確な場所は、サービスがインストールされている場所によって異なります）。

6. ...Cisco¥Desktop¥bin フォルダで、次のコマンドを入力します。

slapcat -f slapd.conf -l backup.ldif -c

Enter キーを押します。backup.ldif という名前のファイルが生成されます。

7. セカンダリ LDAP サービスがインストールされているコンピュータの 
...¥Cisco¥Desktop¥bin フォルダに backup.ldif ファイルをコピーします。

8. セカンダリ データベースをホスティングしている PC で、LDAP モニタ サービ

スがまだ稼動している場合は、これを停止します。

9. ...¥Cisco¥Desktop¥database フォルダにあるファイル repl.log および 
repl.log.lock の内容をすべて削除します。

10. ...¥Cisco¥Desktop¥run¥logs¥replica、...¥Cisco¥Desktop¥logs¥replica、お

よび ...¥Cisco¥Desktop¥logs¥ReplLogs フォルダに入っているファイルをすべ

て削除します。
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11. セカンダリ LDAP データベースを削除するには、...¥Cisco 
¥Desktop¥database フォルダから次のファイルを除くすべてのファイルを削

除します。

 拡張子 .dat を持つファイル

 DB_CONFIG

12. セカンダリ データベース コンピュータでコマンド ウィンドウを開きます。

13. フォルダを ...¥Cisco¥Desktop¥bin に変更します（このフォルダのドライブと

正確な場所は、サービスがインストールされている場所によって異なります）。

14. ...Cisco¥Desktop¥bin フォルダで、次のコマンドを入力します。

slapadd -f slapd.conf -l backup.ldif -c

Enter キーを押します。

15. exit と入力し、Enter キーを押して、DOS ウィンドウを閉じます。

16. セカンダリ コンピュータで LDAP モニタ サービスを再起動します。

17. プライマリ コンピュータで LDAP モニタ サービスを再起動します。
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診断手順
診断手順

サービスのいずれかに問題がある場合は、次のチェック項目を、ここに記載されている

順に実行してください。

基本的なチェック

Agent Desktop に問題がある場合、次のことをチェックします。

 Agent Desktop サービス、Unified CM、Unified CCX、およびその他のシステム 
コンポーネントをホスティングしているコンピュータが実行されている。

 レジストリが正しい（「レジストリ チェック」 （P.48）を参照）。

 ネットワークが正しくセットアップされている（「ネットワーク チェック」 
（P.48）を参照）。

 Agent Desktop サービスが実行中でアクティブである（「アクティブ サービスの

チェック」 （P.48）を参照）。

 Agent Desktop Configuration Setup ユーティリティが正しく実行されている。

詳細については、『Cisco CAD Installation Guide』を参照してください。

電子メールの接続性チェック

Microsoft Exchange サーバへの接続に問題がある場合は、Microsoft Outlook または 
telnet を使用して、アカウントが正しくセットアップされていることを確認する必要が

あります。

接続のテストを開始する前に、次のものが揃っていることを確認してください。

 Microsoft Exchange 2003 または 2007 サーバ。

 IMAP 接続ができるようにセットアップされたサーバ。これは保護された接続、

またはプレーンテキスト接続です。

 IMAP サーバにログイン可能なユーザ アカウント。このアカウントでは、コール 
センターで必要な受信電子メール アドレスそれぞれに対してエイリアスをセッ

トアップする必要があります。

（注）Exchange 2007 では、電子メール エイリアスは適切に処理され

ません。電子メールはメール ボックスには配信されますが、「To:」アド

レスはそのアカウントのプライマリ アドレスに戻されます。エージェ

ント電子メール サービスで適切に電子メールを転送するには、変更さ

れていない、そのままの「To」アドレスが必要です。この制約を回避す

るには、受信電子メール アドレスそれぞれに対して、エージェント電

子メール サービス アカウントを唯一のメンバーとする同報リストを

セットアップします。

 SMTP サーバ（これには、Exchange サーバ、または別のサーバを使用できま

す）。
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Outlook を使用した接続のテスト

Exchange サーバへの IMAP 接続が行われるように Outlook を設定することができます。

接続後、フォルダを確認したり、メッセージを移動したりできるようになります。この

アカウントからメッセージを送信して、SMTP 接続をテストすることもできます。

Outlook を使用して、エージェント電子メール サービスの接続を単独でテストし、接続

の問題がエージェント電子メールの問題なのか、Exchange のコンフィギュレーション

の問題なのかを判断します。

IMAP 接続を設定するには、次の手順を実行します。

1. Outlook メニューから、[Tools] > [E-mail Accounts] を選択します。E-mail 
Accounts ウィザードが表示されます。

2. [Add a new e-mail account] を選択し、[Next] をクリックします。[E-mail 
Accounts - Server Type] ダイアログボックスが表示されます。

3. [IMAP] を選択し、[Next] をクリックします。[E-mail Accounts - Internet 
E-mail Settings (IMAP)] ダイアログボックスが表示されます。

4. アカウント情報を入力し、[Next] をクリックします。

Microsoft Exchange 2007 にユーザを追加する方法について詳細は、次の URL を参照

してください。

http://msexchangeteam.com/archive/2006/09/05/428833.aspx

Telnet を使用した接続のテスト

電子メールの接続をテストするために Telnet を使用して IMAP に接続するには、次の手

順を実行します。

1. Telnet を使用して、コマンド プロンプトに次のように入力し、IMAP に接続し

ます。

telnet mail.myserver.com 143

上のコマンドの結果、次に類似した応答が表示されます。

telnet mail.myimapserver.com 143
Trying 192.168.1.1...
Connected to mail.myimapserver.com (192.168.1.1)
Escape character is '^]'
* OK IMAP4 ready

2. login コマンドを使用して、ログインします。「. login」に続けて、ユーザ名とパ

スワードをスペースで区切って入力します。成功すると、次に類似した応答が表

示されます。

. login accountname@myserver.com *********

. OK User logged in

必要に応じて、次のリンクにアクセスし、Telnet を使用した IMAP への接続に

関する詳細を参照してください。

http://support.microsoft.com/kb/189326
46 2009 年 4 月

http://support.microsoft.com/kb/189326


診断手順
Telnet を使用した SMTP への接続

1. CAD サーバのコマンドラインから次のコマンドを実行します。

telnet mail.mysmtpserver.com 25

成功すると、次に類似した応答が表示されます。

220 mail.mysmtpserver.com Microsoft ESMTP MAIL Service, Version: 6.0.3790.3959 ready at Mon, 10 
Dec 2007 16:53:25 -0600

2. mailserver ドメインを使用して、telnet セッションに次のように入力し、使用

しているメール サーバ ドメインを指定します。

EHLO mysmtpserver.com

成功すると、250 で始まる行のグループに含まれる最後の行に次のように表示

されます。

*
250 OK

3. telnet セッションに AUTH LOGIN と入力し、SMTP サーバにログインします。

サーバから、ユーザ名を求める、暗号化されたプロンプトが表示されます。

base64 で暗号化したユーザ名を入力します。サーバから、パスワードを求め

る、base64 で暗号化されたプロンプトが表示されます。

（注）このためのツールはオンラインで多数用意されています。

「base64 コンバータ」をキーワードに Web を検索してみてください。

4. base64 で暗号化したパスワードを入力します。

たとえば、ユーザ名が <myname> で、パスワードが <mypassword> であると

きにこれらを base64 変換すると bXluYW1l と bXlwYXNzd29yZA== になりま

す。これらを使用したログイン シーケンスは次のようになります。

AUTH LOGIN
334 VXNlcm5hbWU6
bXluYW1l
334 UGFzc3dvcmQ6
bXlwYXNzd29yZA==

成功すると、次のように表示されます。

235 2.7.0 Authentication successful.

5. また、このアカウントを使って、実際に電子メールを送信できるかどうかをテス

トするには、次のようにします。

MAIL FROM:myname@mysmtpserver.com
250 2.1.0 myname@mysmtpserver.com....Sender OK
RCPT TO:recipient@mysmtpserver.com
250 2.1.5 recipient@mysmtpserver.com....Recpient OK
DATA
354 Please start mail input.
Test of telnet smtp
.
250 Mail queued for delivery

Telnet を使用した SMTP 通信のテストに関する詳細は、次の URL を参照してください。
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http://support.microsoft.com/kb/q153119/

http://technet.microsoft.com/ja-jp/library/aa995718.aspx

アクティブ サービスのチェック

このセクションが適用されるサービスは、エージェント電子メール、LRM、コール /
チャット、エンタープライズ、録音統計、BIPPA、および同期だけです。

非冗長システムの場合

 サービスのログ ファイルで、サービスがアクティブであることを示す文がある

か確認します。

冗長システムの場合

 サービスのログ ファイルで、サービスがアクティブであることを示す文がある

か確認します。

 一度にアクティブにできるのは、1 つのサービスにつき、インスタンス 1 つだ

けです。その他のインスタンスは、スタンバイ モードでなければなりません。

レジストリ チェック

Windows Regedit を使用して、

 HKEY_LOCAL_MACHINE¥Software¥Spanlink¥CAD¥Site Setup が存在し、

「Site Setup」 （P.18）に示すエントリが含まれていることを確認します。

 特定のサービスにより使用されるレジストリ エントリが存在し、有効であるこ

とを確認します。「レジストリ エントリ」 （P.18）を参照してください。

ネットワーク チェック

 Agent Desktop サービス コンピュータで、レジストリ値 HKEY_LOCAL_
MACHINE¥SOFTWARE¥Spanlink¥CAD¥Site Setup¥IOR HOSTNAME の IP ア
ドレスが、パブリック NIC の正しい IP アドレスであることを確認します。

 コンピュータで NIC に関する情報を表示するには、コマンド ウィンドウを開い

て、ipconfig /all と入力します。

 ホスト名と IP アドレスが、予想していたものと同じであることを確認します。

 サブネット マスクが正しいことを確認します。これはおそらく、

255.255.255.0 です。
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 複数の NIC が有効化されている場合、プライベート NIC の前にパブリック NIC 
があることを確認します。

1. [Control Panel] で、[Network and Dial-up Connections] をダブルクリッ

クします。

2. メニュー バーから、[Advanced] > [Advanced Settings] を選択します。

3. [Adapters and Bindings] タブの [Connections] ペインに NIC が正しい順序

で並んでいることを確認します。

 Agent Desktop サービス コンピュータから、たとえば Unified CM コンピュー

タなど、コンフィギュレーションのその他のコンピュータに ping してネット

ワーク接続をチェックします。次は逆に、他のコンピュータから Agent 
Desktop サービス コンピュータに ping して、ネットワーク接続をチェックし

ます。このとき、ホスト名と IP アドレスの両方を使用して ping 結果が一致する

ことを確認します。

 ホスト名が使用されている場合、該当する DNS、WINS、およびホスト ファイ

ルが正しいことを確認します。

 特定のサービスとの接続に問題がある場合、コマンド ウィンドウに telnet <IP 
address/hostname> <port> と入力します。ここで、<IP 
address/hostname> には、サービスが実行されているコンピュータの IP アド

レスまたはホスト名、<port> には、このサービスで使用されているポートが入

ります。

 Ethereal（www.ethereal.com）のようなネットワーク プロトコル アナライザ

を使用して、ネットワーク通信を分析します。

メモリ チェック

 コンピュータに、Agent Desktop およびインストールされているその他のソフ

トウェアで最小限必要とされる量のメモリがあることを確認します。メモリの量

が推奨レベルを下回っている場合、これが問題の原因と考えられます。

 Microsoft Perfmon（perfmon.exe）を使用すると、ほとんどのメモリ チェッ

クを実行できます。

[_Total and process of interest] に次のカウンタを追加します。

 Private Bytes

 Virtual Bytes

 Handle Count

 Thread Count

これらのカウンタの値が、一定量にならなかったり、減少したりせず、増え続け

る場合、そのプロセスでメモリがリークしていると考えられます。

あるプロセスについて、これらのカウンタの値が使用されている総メモリの

大部分を占めている場合、これが問題となっている可能性があります。プロ

セスの中には、通常、他のプロセスよりも多くのメモリを使用するものもあ

るので注意してください。
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 コンピュータをリブートし、問題が解決されるかどうかを確認します。プロセス

のメモリ使用率がどのくらい急速に、どの程度増加するかを確認します。

CPU チェック

 コンピュータが、Agent Desktop およびインストールされているその他のソフ

トウェアで最小限必要とされるプロセッサを搭載していることを確認します。プ

ロセッサが推奨レベルを下回っている場合、これが問題の原因と考えられます。

 Task Manager を使用して、CPU 使用率を基準にプロセスおよびアプリケー

ションを並べ替えます。最も多くの CPU を使用しているプロセスは何かを確認

します。

 Windows Perfmon（perfmon.exe）を使用して、さらに CPU チェックを実行

します。

— [Processor] > [_Total and each CPU]、および [Process] > [_Total and 
process of interest] に %Processor Time カウンタを追加します。

— 最も多くの CPU を使用しているプロセスは何かを確認します。

— あるプロセスのカウンタの値が使用されている総 CPU の大部分を占めてい

る場合、これが問題となっている可能性があります。短期間の急上昇は問題

ありませんが、CPU 使用率が高い状態が長時間続くのは問題です。

 コンピュータをリブートし、問題が解決されるかどうかを確認します。

ブロックされたポートのチェック

ポートがブロックされているかどうかをチェックするには、次の手順を実行します。

 Telnet を使用して次のようにします。

1. サービスが実行中でアクティブであることを確認します。

2. コマンドラインに telnet <hostname/IP address> <port> と入力し、

Enter キーを押します。ここで、<hostname/IP address> にはサービス コ
ンピュータのホスト名または IP アドレス、<port> にはサービスがリッスン

しているポートが入ります。

3. これが成功すると、コマンド ウィンドウがクリアされ、カーソルが左上隅

に表示されます。ウィンドウを閉じてください。

4. Telnet が失敗した場合、接続エラーが表示されます。

 クライアントおよびサーバ コンピュータのファイアウォール設定をチェックし

ます。

 ファイアウォールのログをチェックします。
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問題 フェールオーバーの直後に、コールに対する [Enterprise Data] フィール

ドに部分的なコール履歴、または部分的なデータが表示されます。

症状： エージェントがコールを受信したときに、[Enterprise Data] ペイ

ン、または [Enterprise Call History] ペイン、もしくはこの両方に、

フェールオーバーの前に開始されたコール、またはフェールオーバー中に

発生したコールに対するデータが部分的にしか表示されません。

原因： フェールオーバー中、システムにアクティブ コールが存在してい

る可能性があります。エンタープライズ サービスは、コールのスナップ

ショットを作成して、このようなコールの情報を取得しようとします。こ

のスナップショットは完全なコール履歴を提供していません。データが欠

落しています。

ソリューション これは予想される動作です。フェールオーバー後、エンタープライズ 
サービスが作動しているときに発生したコールのデータは完全なものにな

ります。

問題 エージェントの PC の CPU 使用率が 99% になり、PC がロックされます。

ソリューション この現象は、Agent Desktop が実行され、デスクトップ モニタリングを

使用して、スーパーバイザによりモニタリングまたは録音、またはエー

ジェントにより録音されているときに、Windows の [Network and 
Dialup Connections] ウィンドウでスニファ アダプタを無効にした場合に

発生します。Agent Desktop の実行中にスニファ アダプタを再度有効に

しても問題は解決されません。通常の機能を復元するには、Agent 
Desktop を停止し、スニファ アダプタを再度有効にしてから、Agent 
Desktop を再起動する必要があります。

問題 Windows XP を使用しているエージェントが Agent Desktop を起動する

ことはできますが、アクティブ状態に移行することができません。

ソリューション Windows XP は、Internet Connection Firewall（ICF; インターネット接

続ファイアウォール）がアクティブになるように設定できます。ICF は、

コンピュータとの間のトラフィックをすべて追跡し、特定のコンピュータ

から発信された情報だけを通過させます。このコンピュータ以外のところ

から発信されたメッセージは、破棄されます。
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この問題を解決するには、ICF をオフにする（コンピュータへの管理者権

限が必要です）か、CAD サーバなど、「正常」だとわかっている接続が含

まれるようにデフォルトを上書きします。

問題 エージェントに対して「The agent- or workflow-initiated action request 
failed」というエラー メッセージが表示されました。

ソリューション このエラー メッセージは、たとえば、コール制御処理やエージェント状

態の変更などの Unified CCX Engine への要求が拒否されたときに表示さ

れます。この処理をもう一度実行してください。

問題 エージェントが Agent Desktop にログインできません。

症状：エージェントが Agent Desktop にログインしようとすると、エ

ラー メッセージが表示されます。表示される可能性のあるエラー メッ

セージは次のとおりです。

 Failed to log into CTI Manager Server!Please talk to your 
administrator.

 The ID you entered was not found.

 Unable to log agent in.

 A critical error has been received.Either your phone or Unified CM 
is offline.If you are not already logged out, you may need to logout 
and try to log in again.

原因： エラー メッセージに応じて、原因には次のいずれか 1 つが考えら

れます。

 CTI Manager Server に関係するエラー メッセージの場合、問題は、

[Enable CTI Application Use] がこのエージェントのユーザ ID に対し

て設定されていない、Unified CM サーバで CTIManager サービスが

実行されていない、または使用したパスワードが間違っていることに

ある可能性があります。

 入力された ID が見つからなかった場合、ID が無効である可能性があ

ります。

 エージェントがログインできない場合、そのエージェントの電話が 
Unified CM の RmCm プロバイダーと関連付けられていない可能性が

あります。

 重大なエラー メッセージが表示された場合、Unified CM サーバがオ

フラインになっているか、またはエージェントの IP フォンがリセッ

トされた可能性があります。
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ソリューション エラー メッセージに関連する問題を修正します。

 CTI Manager サーバに関連するメッセージの場合は、Unified CM 
サーバで CTIManager サービスが実行されていることを確認します。

 ID が見つからなかった場合は、ユーザ ID が正しく入力されているこ

とを確認します。ユーザ ID では大文字小文字が区別されます。

Unified CM で、そのエージェントに対して設定されたパスワードが

正しく使用されていることを確認します。

 エージェントの電話が RmCm プロバイダーと関係付けられていない

場合は、Unified CM Administration アプリケーションにアクセスし

ます。[User Management] > [Application User] を選択してから目

的の RmCm プロバイダーを選択します。[Application User 
Configuration] ページの [Device Information] セクションで、エー

ジェントの IP フォンと RmCm プロバイダーを関連付けます。

 重大なエラー メッセージが表示された場合は、Unified CM サーバが

オンラインであること、およびエージェントの電話が稼動中であるこ

とを確認します。

 Unified CCX セットアップが Unified CM サーバのクラスタをポイン

トしている場合、Unified CM は稼動しています。

問題 [Enterprise Data] フィールドにデータが表示されません。

症状： エージェントがコールを受信したときに、[Enterprise Data] ペイ

ンに、予想していたデータが表示されません。

原因： Unified CCX サーバが、エンタープライズ データをエンタープライ

ズ サービスから Agent Desktop に正しく送信していません。この状況

は、スクリプト、または Desktop Administrator の [Enterprise Data 
Configuration] セクションでステップが正しく設定されていない場合に発

生します。また、エンタープライズ データ サブシステムとエンタープラ

イズ サービスが同期されていない場合にもこのような結果になります。

ソリューション 次の手順を実行してください。

1. スクリプトおよび Desktop Administrator の [Enterprise Data 
Configuration] セクションでステップの設定を確認します。

2. エンタープライズ サービスを停止して再起動します。

3. それでも問題が解決されない場合は、Unified CCX Engine を停止し

て再起動します。
2009 年 4 月 53



Cisco CAD トラブルシューティング ガイド
問題 [E-mail Ready] および [Not Ready] ボタンがツールバーに表示されませ

ん。

ソリューション 次の手順を実行してください。

1. エージェント電子メール機能が正しく設定されていることを確認しま

す。

2. Application Administrator で、エージェントが少なくとも 1 つの電

子メール CSQ が割り当てられているリソース グループに属している

ことを確認します。

考えられる原因は次のとおりです。

 その電子メール機能は Premium パッケージだけで使用できます。

 電子メール機能は設定されていません。

 エージェントは、どの電子メール CSQ にも属していません。

問題 [E-Mail Ready] ボタンがアクティブ化されたときに、エージェントは電子

メールを受信していません。

ソリューション 次の手順を実行してください。

1. Contact Service Queue Statistics のリアル タイム表示をチェック

し、キューの中に電子メールがあることを確認します。

2. 電子メール サーバが正しく設定されていること、およびエージェント

電子メール サービスが Exchange サーバに接続できることを確認し

ます。

考えられる原因は次のとおりです。

 エージェントが属しているキューのいずれにも電子メールはあり

ません。

 電子メール機能が適切に設定されていません。

問題 Agent Desktop のステータス バーに「Partial Service」、または「No 
Service」というメッセージが表示されています。

症状： エージェントの Agent Desktop のステータス バーに「Partial 
Service」、または「No Service」というメッセージが表示されています。
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原因： Agent Desktop によりサービスと通信できないことが検出される

と（通常、サービス障害発生から 3 分以内）、サービスの一部、または全

部で障害が発生していることを示すために、メッセージ「Partial 
Service」または「No Service」が表示されます。

ソリューション ステータス バーのメッセージをダブルクリックして、[Server Status] 
ポップアップ ウィンドウを表示します。このウィンドウには Agent 
Desktop 機能、およびどの機能がサービス障害による影響を受けている

かがリストされます。障害を起こしたサービスが再び使用可能になったこ

とが Agent Desktop により検出されると（通常、サービス リカバリから 
1 分以内）、ステータス バーに「In Service」と表示され、サービスが回

復したことが示されます。

問題 エージェントが「Ready」状態と「Reserved」状態の間を行ったり来た

りしています。

症状： エージェントの状態が「Ready」と「Reserved」の間で切り替わ

り、一定になりません。

原因： これは、エージェントの Unified CCX 内線の先頭の数字と同じ数字

で始まるダイヤル プランが存在する場合に起こることがあります。この

ような状況で、エージェントの内線の桁数がダイヤル プランで設定され

ている桁数よりも少ない場合、この症状を引き起こす可能性があります。

ソリューション 次の 2 つの事項が同時に発生しないことを確認してください。

 エージェントの Unified CCX 内線が、Unified CM に存在するダイヤ

ル プランの先頭の数字と同じ数字で始まる。

 エージェントの Unified CCX 内線の桁数が、このダイヤル プランで

設定されている番号の桁数よりも少ない。

問題 エージェントが Agent Desktop を起動するときに、次のエラー メッセー

ジが表示されます。「A licensing error has occurred. Please try again in 
five minutes. If the problem persists, please see your log file or the 
System Administrator for details.」

症状： エージェント PC から、Agent Desktop サーバ（ポート 65432）
の LRM サービスへの Telnet テストが失敗します。LRM サービスは実行

中で、エージェントは接続できる場合があります。Cisco Security Agent
（CSA）はインストールされ、Agent Desktop サーバ上で実行中です。

CSA ログには、次のように記録されています。「Event: Possible SYN 
Flood detected. Source addresses include 10.X.X.X. TCP ports, 
including port 59004, SYN Flood protection has been enabled.」
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原因： CSA は SYN フラッド検出モードです。エージェント PC ではファ

イアウォールが有効化され、パケットがブロックされているため、CSA 
は PC が無反応であると見なしています。

ソリューション 短期的なソリューション：Agent Desktop サーバで CSA を再起動します。

長期的なソリューションには次のオプションがあります。

オプション 1：システムをそのままにしておきます。リスク：SYN フラッ

ド検出モードが有効になることがあります。この場合、エージェントがロ

グインできなくなる可能性があります。すぐに発見されない場合、SYN 
フラッドが自動的にオフになるまで（約 2 時間）、この問題が続きます。

オプション 2：SYN フラッド検出モードをオフにします。リスク：サーバ

が SYN フラッドに対して開放されたままになります。

オプション 3：エージェント PC ファイアウォールをオフにします。リス

ク：エージェント PC がウィルスに対して脆弱なままになる可能性があり

ます。

推奨：オプション 2。SYN フラッドは、通常、最新のネットワークに対す

る影響力を持ちません。

問題 エージェントが電話を切るたびに、Agent Desktop が消えます。

ソリューション 通常モードでは、アクティブ コールがない場合、Agent Desktop は自動

的に最小化されます。この動作は、Desktop Administrator で設定されて

います。[Agent Desktop] ウィンドウが最小化されないようにするには、

[Preferences] をクリックし、[Always Open] または [Always on Top] を
選択します。

問題 管理者が Desktop Administrator で変更を行いましたが、その変更が 
Agent Desktop に反映されません。

ソリューション 変更を有効にするには、Agent Desktop を再起動する必要があります。
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問題 エージェントは（[File] メニューから）Agent Desktop のウィンドウ動作

を変更しましたが、Agent Desktop を再起動したとき、設定は保存され

ていませんでした。

ソリューション Agent Desktop を使用してローカル設定に対して行われた変更は、グ

ローバル設定を一時的に上書きするだけです。永続的な変更には 
Desktop Administrator を使用する必要があります。

問題 電話会議中に、会議メンバーが <Unavailable> と表示されることがあり

ます。

ソリューション <Unavailable> は、スイッチの外部にいる参加者を表します。スイッチ

はデスクトップに外部参加者のトランク番号を送信しますが、デスクトッ

プではこの番号には意味がありません。Agent Desktop により、トラン

ク番号は <Unavailable> に置き換えられます。

問題 エージェントはスーパーバイザに緊急チャット メッセージを送信しまし

たが、スーパーバイザはこのメッセージを受け取っていません。

ソリューション スーパーバイザが緊急チャット メッセージを受信できるのは、メッセー

ジを送信したエージェントが属しているチームをモニタリングしている場

合だけです。

問題 Agent Desktop の実行中に、エラー メッセージ「Macro file failed to 
open」が表示され続けます。

ソリューション デスクトップ上で実行されているウィルス スキャン アプリケーションを

すべてオフにします。ウィルス スキャン アプリケーションが、ファイル

を開くコールを妨害して自身の処理を先に実行しようとします。これによ

り、他のアプリケーションからのファイルを開く操作が制限される場合が

あります。

問題 エージェントが Agent Desktop でスキル統計情報を表示できません。

ソリューション エージェントがスキル グループに割り当てられていない場合、使用でき

るスキル統計情報はありません。
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問題 コールを保留にすると、エージェントがコールを受信できないことがあり

ます。そのコールを切断しても、エージェントの状態は On Hold のまま

です。Agent Desktop を終了して再起動しても、問題は解決されません。

ソリューション Unified CM Administration のタスクは、デバイスと JTAPI ユーザを関連

付けることです。ペリフェラル ゲートウェイ JTAPI ユーザは、エージェ

ントの電話と関連付ける必要があります。IP IVR JTAPI ユーザは、IP IVR 
の仮想ポートに対応する CTI ポートと関連付ける必要があります。

これらのデバイス カテゴリはそれぞれ独立しています。デバイスは、複

数のカテゴリに属することはできません。デバイスを 1 つのカテゴリに

正確に割り当てられない場合、問題が発生します。

問題 エージェントがコールに応対している間、エージェント状態を Not Ready 
に変更できないことがあります。そのため、このエージェントは、アプリ

ケーションを終了した後でも、ACD からのコールを受信し続けます。

ソリューション Unified CM Administration のタスクは、デバイスと JTAPI ユーザを関連

付けることです。ペリフェラル ゲートウェイ JTAPI ユーザは、エージェ

ントの電話と関連付ける必要があります。IP IVR JTAPI ユーザは、IP IVR 
の仮想ポートに対応する CTI ポートと関連付ける必要があります。

これらのデバイス カテゴリはそれぞれ独立しています。デバイスは、複

数のカテゴリに属することはできません。デバイスを 1 つのカテゴリに

正確に割り当てられない場合、問題が発生します。エージェントの電話

が、ペリフェラル ゲートウェイ JTAPI ユーザと関連付けられていること

を確認してください。

問題 エージェントは、複数のネットワーク アダプタ カードを搭載したコン

ピュータで、Desktop Agent と IP ソフトフォン（たとえば、IP 
Communicator）を使用しています。このエージェントがネットワークに

接続するために、ある NIC から別の NIC へ使用を切り替えると、この

エージェントはログインできません（たとえば、イーサネット、またはワ

イヤレス接続のいずれかを使用してネットワークに接続できるラップトッ

プで、Agent Desktop と IP ソフトフォンを実行している状況がこれに相

当します）。
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ソリューション NIC はそれぞれ、独自の MAC アドレスを持っています。Agent Desktop 
を正常に動作させるには、Unified CM は、1 つの MAC アドレスを 1 つ
の内線に関連付ける必要があります。Unified CM が、複数の NIC のうち 
1 つしか認識していない場合、機能するのはその NIC だけです。複数の 
NIC を持つコンピュータをエージェントが使用する場合、それぞれの NIC 
の MAC アドレスを認識するように、Unified CM を設定する必要がありま

す。

問題 エージェントが予想外にログアウトされます。

ソリューション 次の理由が考えられます。

 同じ ID または内線を持つ別のエージェントがログインしたため、最

初のエージェントがログアウトされました。

 スーパーバイザがエージェントをログアウトさせました。

 テレフォニー サービスに障害が発生しました。

 ネットワークに障害が発生しました。

問題 エージェントは内線通話の発信および受信はできますが、外線通話を発信

しようとするとエラーが発生します。

ソリューション ダイヤル ストリング プロパティは、発信通話に正しく設定しなければな

りません。スイッチの中には、外線に接続するために、自動的に 9 をダ

イヤルするように設定されているものもありますが、場合によっては、9 
を手動でダイヤルする必要があります。ダイヤル ストリングは、スイッ

チがどのように設定されているかに配慮する必要があります。

問題 エージェントのコール制御処理が適切に機能しません。

ソリューション ダイヤル パッドを使用して、手動で同じ処理を実行してみてください。

コール制御処理で使用される場合、電話番号は、手動でコールするときと

同じようにフォーマットされます。ダイヤル ストリングが発信通話に適

切に設定されていることを確認してください。
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問題 1 つのイベントに 4 つの処理が割り当てられていますが、最初の 2 つだ

けが実行されます。

ソリューション 一連の処理を実行する場合、処理のいずれかが失敗すると、実行は停止し

ます。これは、直前の処理が正しく実行されたかどうかが次の処理の実行

を左右する場合があるためです。3 番目の処理が失敗した原因を調べて修

正してください。

問題 ダイヤル パッドのダイアログボックスに表示される電話帳が最新のコー

ル リストだけです。

ソリューション 管理者が電話帳を無効にしています。

問題 グローバル電話帳は表示されますが、個人用の電話帳がありません。

ソリューション 管理者が個人用の電話帳を無効にしています。

問題 電話帳を編集するときに、エージェントは姓、名、または注を編集した後

で、エントリを追加することができません。

ソリューション エージェントは、[Add] ボタンが有効化される前に、電話番号を入力する

必要があります。

問題 エージェントは個人用の電話帳は編集できますが、それ以外の電話帳は編

集できません。

ソリューション 個人用の電話帳は他のエージェントと共有されません。その他の電話帳は

共有され、管理者だけが編集できます。

問題 エージェントは Log Viewer 実行可能ファイルを検索することができませ

ん。

ソリューション Log Viewer は、独立した実行可能ファイルではなく、Agent Desktop の
一部です。Log Viewer にアクセスするには、Agent Desktop メニュー 
バーの [File] - [View Logs] オプションを選択します。
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問題 Log Viewer を開くと、最初の行に <N/A> と表示されています。

ソリューション 選択した日のデータが存在しない場合、Log Viewer の先頭行には <N/A> 
と表示されます。

問題 エージェントが表示オプションを変更しましたが、キャンセルを押しまし

た。フィルタへの変更がキャンセルされないのはなぜですか。

ソリューション フィルタ ダイアログボックスにはそれぞれ、[Cancel] ボタンがついてい

ます。承認されたフィルタは保存されます。列に対して行われた変更を

キャンセルできるのは、オプション ダイアログボックスの [Cancel] ボタ

ンだけです。

問題 損失したイベントでは、キーストローク マクロが切断時に正しく再生さ

れません。

ソリューション Agent Desktop が通常モード（コール受信時に最大化され、コール アピ

アランスがないときに最小化される）で実行している場合、キーストロー

ク マクロが誤ったウィンドウに再生される場合があります。コールが切

断された時点で Agent Desktop が最小化されると、これにより、ター

ゲット キーストローク マクロ ウィンドウからフォーカスが奪われます。

これを修正するには、キーストローク マクロの先頭に 
[Delay]<milliseconds> コマンドを指定してください。ここで、

<milliseconds> には必要な遅延の長さが入ります。このコマンドによっ

てキーストローク マクロを再生する前に Agent Desktop を最小化するた

めの時間が確保されます。次に例を示します。

[DELAY] 1000
[APPLICATION:NOTEPAD=UNTITLED - NOTEPAD]

問題 マクロが正常に再生されません。

ソリューション キーストロークをウィンドウで再生する場合は、まず Agent Desktop が
ウィンドウを検索する必要があります。マクロを記録するときは、Agent 
Desktop でウィンドウのタイトルとクラス名（ウィンドウに関連付けら

れた内部 Windows 変数）を保存します。再生時に、Agent Desktop は次

の順序で検索します。

1. 保存されたタイトルとクラス名の付いたウィンドウを検索します。

2. 保存されたクラス名の付いたウィンドウを検索します。
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3. 保存されたタイトルの付いたウィンドウを検索します。

Agent Desktop がこれらの条件のうち 1 つ以上と一致するウィンドウを

検索できない場合は、エラー メッセージが表示されます。

同じ名前とクラス名を持つウィンドウが 2 つある場合は、Agent Desktop 
が誤ったウィンドウでマクロを再生する可能性があります。

同じクラス名を持つウィンドウが複数存在し、ターゲット ウィンドウの

タイトルが変更された場合、Agent Desktop は誤ったウィンドウでマク

ロを再生する可能性があります。

一部のコンパイラやクラス ライブラリは、すべてのウィンドウに同じク

ラス名を使用します。社内アプリケーションを開発している場合は、アプ

リケーションでクラス名の変更が必要になる可能性があります。

問題 ターゲット アプリケーションが実行中であるにもかかわらず、キースト

ローク マクロが再生されません。

ソリューション Agent Desktop はアプリケーションのクラス名とタイトルを使用して、

ターゲット アプリケーションを検索します。アプリケーションによって

は、画面を変更するときにタイトルとクラス名が変更されます。この場

合、Agent Desktop がターゲット アプリケーションを見つけられない場

合があります。ウィンドウ タイトルまたはクラス名だけを使用して、

ターゲット アプリケーションを検索してみてください。

例 1：タイトル（NOTEPAD）とクラス（UNTITLED - NOTEPAD）の両方

を検索。

[APPLICATION:NOTEPAD=UNTITLED - NOTEPAD]
[SHIFT] D
など。

例 2：クラス（NOTEPAD）だけを検索。

[APPLICATION:NOTEPAD=]
[SHIFT] D
など。

例 3：タイトル（UNTITLED - NOTEPAD）だけを検索。

[APPLICATION:=UNTITLED - NOTEPAD]
[SHIFT] D
など。
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問題 管理者がマクロを作成し、一定の遅延を加えました。マクロの実行中に 
PC がロックしているように見えます。

ソリューション マクロが実行されると、オペレーティング システムが PC を支配し、すべ

てのユーザ入力をロックします。これはオペレーティング システムの特

性です。マクロの実行時間の短縮を試みてください。

問題 キーストローク マクロが誤ったウィンドウで誤ったキーを再生します。

ソリューション マクロの再生が常に同じ場所から開始されるようにしてください。マクロ

を記録したときと同じ開始位置にカーソルを置くことで、マクロを同じ開

始ウィンドウから開始するようにします。

問題 マクロが再生されるときに、キーストロークが見つからないか、PC が
ロックされているように思われます。

ソリューション 多様なシステムおよび設定があるため、マクロの再生速度も異なります。

マクロによるキーストローク再生速度を下げる場合は、次のセクションを 
fastcalllocal.ini ファイルに追加します。

[MacrosMisc]
DelayTime= <n ミリ秒 >

ここでは、n ミリ秒は各マクロ イベント間で遅延を発生させるミリ秒単位

の値です。

問題 マクロの実行後も、フォーカスが再生されたアプリケーション内にとど

まっています。フォーカスを Agent Desktop（または他のアプリケー

ション）に変更するにはマクロをどのように記述すればよいですか。

ソリューション フォーカスを Agent Desktop に変更するには、次の行を末尾に挿入して

マクロを編集します。

[APPLICATION:AGENT_DESKTOP=AGENT_DESKTOP]

Agent Desktop 以外のアプリケーションにフォーカスを移動することも

できます。挿入する行を決定するには、ダミーのマクロを作成して、アプ

リケーションにキーストロークをいくつか再生します。記録が終了した

ら、ダミー マクロからアプリケーションのテキスト識別情報を編集する

マクロにカット アンド ペーストします。
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問題 マクロを実行していると、PC が短時間ロックしているように見えること

があります。

ソリューション [DELAY] 文があると、マクロはシステムを制御し続けるために、システム

がユーザからの入力をフックするように仕向けます。PC は動作しますが、

マクロが再生を終了するまではすべてのユーザ入力を受け付けなくなりま

す。この問題を防ぐには、遅延時間をできるだけ短くしてください。

問題 マクロの実行中にエージェントによって Ctrl+Alt+Del キーが押され、

Agent Desktop のウィンドウがロックされています。

ソリューション マクロの記録中に [Start] をクリックしたり、Ctrl+Break、Ctrl+Esc、ま

たは Ctrl+Alt+Del キーを押したりできません。[Start] をクリックすると、

Windows オペレーティング システムは、システムのキーボード フックを

解除します。

問題 エージェントがブラインド会議に参加していますが、コールに参加してい

るすべての参加者を表示できません。

ソリューション Agent Desktop 6.6 では、ブラインド会議は、アラート参加者を会議に追

加する機能として定義されています。Supervisor Desktop または Agent 
Desktop のいずれかで、ブラインド会議に参加するすべての参加者が表

示されない場合があります。これは CTI サーバ ソフトウェアの制限事項

です。

問題 Agent Desktop のフォント サイズを大きくすると、エージェント名や内

線などのステータス バーの情報が切り捨てられます。

ソリューション フォント サイズを大きくした後に、ステータス バーの情報が切り捨てら

れずにすべて表示されるようにするには、Agent Desktop を再起動する

必要があります。
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問題 エージェント状態またはコール ログを表示しようとしても、データが表

示されません。

ソリューション エージェントが、その該当日に、コールを受信していないか、ログインし

ていない可能性があります。エージェントの PC またはスーパーバイザの 
PC の時計が正しいタイム ゾーンに設定されていない可能性があります。

（注）すべての状態とコール時刻はサーバ時刻を基準にしていま

す。

問題 アップグレード後、Agent Desktop の [Desktop Preferences] ダイアロ

グの [Accessibility Options] タブの [Report Font Size] フィールドが空白

になっています。

ソリューション ドロップダウン リストからフォント サイズを選択します。最小レポート 
フォント サイズは 15 です。

問題 エージェントのスクリーン リーダーがエージェント レポートのテーブル 
セルの内容を読み取りません。

ソリューション 初期状態では、レポート内のテキストをスクリーン リーダーで読み取れ

ない場合があります。スクリーン リーダー プログラムでレポート セルの

テキストを強制読み取りする方法については、スクリーン リーダーのマ

ニュアルを参照してください。

問題 CAD 6.4(1) から CAD 6.6 に CAD をアップグレードすると、エージェン

トからグローバルまたは個人電話帳、あるいはその両方を参照できませ

ん。アップグレード前は、両方の電話帳を利用できました。

ソリューション 電話帳は Cisco Desktop Administrator で使用可能になっていなければな

りません。

1. Desktop Administrator で、[Call Center 1] > [Work Flow 
Configuration] > [Phone Book] を選択します。

2. 正しい電話帳（グローバルまたは個人、あるいはその両方）が選択さ

れていることを確認してから、[Apply] をクリックします。
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問題 管理者が Unified CCX サーバから CAD アプリケーションをホスティング

しているデスクトップに Telnet 接続できません。

ソリューション Unified CCX サーバとデスクトップの間のファイアウォールでは、デスク

トップのアクセスが許可されるように、ポート 59000 ～ 59030 が開い

ていなければなりません。
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エージェントの電子メールに関する問題

問題 IMAP または SMTP に接続できません。

ソリューション この問題の原因として、入力された電子メール アドレスまたはログイン

およびパスワード情報が間違っていることが第一に考えられます。

Outlook または Telnet を使用して接続を確認してください。詳細は、「電

子メールの接続性チェック」 （P.45）を参照してください。

問題 電子メールを送信できない、または送信に時間がかかります。

ソリューション Telnet を使用して SMTP サーバへの基本接続を確認した後、ウィルス 
チェック ソフトウェア、ファイアウォール、またはその他のセキュリ

ティ ソフトウェアがメッセージの送信を妨げていないかどうか確認して

ください。SMTP はマルウェアによって非常に一般的に使用されるプロト

コルであるため、結果としてウィルス チェック ソフトウェアは SMTP を
使用するプログラムを非常に疑わしいプログラムだと認識します。ウィル

ス チェック ソフトウェア、ファイアウォール、およびその他のセキュリ

ティ ソフトウェアを一時的にオフにしてみてから、問題を診断してくだ

さい。

問題 電子メールがエージェントにルーティングされません。

ソリューション 電子メールをエージェントにルーティングするには、着信アドレスごとに

電子メール配信リストを作成する必要があります。また、これらのアドレ

スすべてを管理経由で、エージェント電子メール機能を設定した CSQ に
マッピングしなければなりません。Exchange 2007 は着信電子メールの 
[To:] に指定されたアドレスを上書きしますが、これはエイリアスではな

く配信リストを使用しなければならないためです。

問題 [E-mail Ready] または [E-mail Not Ready] ボタンがデスクトップに表示

されています。

ソリューション エージェントがプレミアム ライセンスを所有し、電子メール CSQ として

指定されている 1 つ以上の CSQ に属している場合に限り、電子メール機

能が使用可能になります。プレミアム ライセンスを所有し、エージェン

トが 1 つ以上の電子メール CSQ に属していることを確認してください。
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問題 IMAP が Outlook で動作し、ログイン情報が正しいことが確かであるにも

かかわらず、IMAP にログインできません。

ソリューション Outlook で動作し、Telnet で動作しない場合には、おそらくログインに使

用しているアカウントが NT ドメインのアカウントである可能性が考えら

れます。IMAP にログインするときは、次のログイン情報を指定する必要

があります。

NT ドメイン /NT アカウント / エイリアス 

たとえば、電子メール アドレスが「Jane.Doe@myserver.com」、

Windows NT のログイン名が「doe」、NT ドメイン名が「mydomain」、
Exchange メールボックス名が「Jane Doe」の場合は、ログイン時の

ユーザ名に「mydomain¥jdoe¥Jane.Doe」と指定する必要があります。

問題 IMAP にログインできましたが、今度は SMTP が動作しません。

ソリューション SMTP ログインは IMAP ログインのように複雑ではありません。アカウン

ト名を使用してください。前述の例では、「jdoe」になります。

問題 一部の添付ファイルを受信できません。

ソリューション 電子メール サーバで、メッセージの最大サイズが制限されている可能性

があります。また、サーバまたはウィルス チェック ソフトウェアが、マ

ルウェアを含んでいるおそれのある特定の種類の添付ファイルをフィルタ

で除外している可能性があります。

問題 電子メールは送信されているように思われますが、宛先アドレスに到達し

ませんでした。

ソリューション メッセージが大きすぎる、メールボックスが満杯である、または添付ファ

イルの制限などの理由により、受信者のメールボックスで電子メールが拒

否されている可能性があります。このような状況では一般的に、受信者の 
SMTP サーバが配信ステータス メッセージを送信者に送り返します。

エージェント電子メール サービスでは、この種類のメッセージを検出し、

メッセージをログ ファイルに出力してから、メール ストアの「System 
Status」フォルダにメッセージを移動します。前述のように、Outlook を
使用してこのフォルダを手動で検査して、各フォルダの送信済みおよび処

理済みのメッセージ ストアに配信ステータス メッセージを関連付けられ

ます。処理済みのメッセージを再度キューに入れて、エージェントが再度
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メッセージに対応できるようにする場合は、メッセージをドラッグして受

信箱に戻します。受信者がメッセージを受信できると思われる場合は、別

の方法として、送信済みのメッセージを開き、手動で再送信を試みること

もできます。また、エラーの原因が添付ファイルである場合には、添付

ファイルを削除してから、メッセージを再送することもできます。

問題 エージェントに下書きの電子メールがありますが、エージェントはオフィ

スにいません。どうすれば、電子メールを再度キューに入れ、別のエー

ジェントに処理させることができるでしょうか。

ソリューション CAD デスクトップを使用して、当該エージェントとしてログインすると、

電子メールを再度キューに追加できます。

問題 破損した電子メールまたは不正な形式の電子メールが受信箱にあります

が、エージェントでルーティングしたり、読み取ったりできないため、削

除したいと思っています。

ソリューション 別のエージェントで Outlook にログインし、手動で受信箱から電子メー

ルを削除してください。

問題 スーパーバイザがスーパーバイザ ワークフロー処理を使用して、電子

メールを送信できません。ただし、電子メール クライアントがスーパー

バイザの認証資格情報で設定されている場合は、スーパーバイザは直接電

子メールを送信できます。スーパーバイザのログ ファイルには、エラー 
メッセージが何も出力されていません。

ソリューション 一部のウィルス チェック ソフトウェアによって電子メールが送信できな

くなっている可能性があります。スーパーバイザの PC 上のすべてのウィ

ルス チェック ソフトウェアを使用不能にしてください。

問題 サーバのメールボックスには多数のメールがありますが、エージェント電

子メール サービスはメール ストアから電子メールをまったく取得してい

ません。

症状：エージェント電子メール サーバは SMTP 25 番ポート経由で 
Exchange サーバに接続できませんでした。
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ソリューション McAfee VirusScan 8.0 では大量の電子メール送信を防止します。これに

よって、25 番ポートへの Telnet 接続がブロックされます。McAfee 
VirusScan 8.0 使用時のこの問題を解決するには、次の手順に従ってくだ

さい。

1. VirusScan コンソールを起動します。

2. [Access Protection Properties] を選択します。

3. [Ports to block] の下の [Rule against Port 25] の [Prevent mass 
mailing worms from sending mail] をクリアします。これで、25 番
ポートを使用して、メール サーバに Telnet 接続できるようになりま

す。

問題 エージェントに電子メール関連のボタンが表示されません。

ソリューション 次の点を確認してください。

 コンタクト センターでプレミアム ライセンスを使用している。

 エージェント サービスが 1 つ以上の電子メール CSQ に属している。

 統合ブラウザがエージェントのワークフロー グループに対して使用可

能になっている。

 ワークフロー管理者で、エージェントのワークフロー グループの電子

メール関連ボタンが表示されている。

何らかの変更を行った場合は、Agent Desktop を再起動してください。

問題 エージェントが電子メールを全く受信していません。

ソリューション エージェント電子メール アカウントが Active Directory でロックされて

いるかどうかを確認してください。

問題 エージェントが [Contact Appearance] ペインで電子メールを選択する

と、「An error has occurred」というエラー メッセージが表示されます。

Unified CCX サーバではホスト名を使用して Exchange サーバに Ping 接
続できますが、クライアント デスクトップではできません。

ソリューション ホスト名がメール ストアで使用されている場合は、クライアント デスク

トップがホスト名を解決できることを確認してください。ホスト名解決が

できない場合は、ホスト名の代わりに IP アドレスを使用してください。
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バックアップと復元に関する問題

問題 BARS でファイル バックアップができません。

ソリューション この症状は、クライアントまたはサーバがサイド B で LDAP に接続でき

ないことを示しています。この問題を修正するには、サイド B を再起動

します。問題が解決しない場合は、サイド A とサイド B の両方を再起動

します。
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CAD-BE に関する問題

問題 CAD-BE URL を入力した後に、ブラウザで HTTP ステータス 404 が返さ

れます。

ソリューション CAD-BE に使用されている URL が正しくありませんでした。正しい URL 
を使用してください。URL では大文字と小文字が区別されます。正しい 
URL を次に示します。ここで、<Unified CCX サーバ > は Cisco Unified 
CCX をホストするサーバの IP アドレスです。

http://<Unified CCX サーバ >:6293/cadbe/CAD-BE.jsp

問題 ブラウザで「The page cannot be displayed.」というエラーが返されま

す。

ソリューション ブラウザは、Tomcat サービスと通信できません。

 IP アドレスまたはホスト名が有効な CAD サーバのものであるか確認

してください。

 ポートが 6293 であることを確認してください。使用するポートは、
C:¥Program Files¥wfavvid¥tomcat_
appadmin¥conf¥server.MADM.xml の <!-- Normal HTTP --> セク

ションの <Parameter name="port" value="6293"/> で指定されま

す。

 Unified CCX Admin Control Center で BIPPA サーバ上で Cisco 
Unified CCX Administration が実行中かどうかを確認します。

 6293 番ポートがクライアントまたはサーバ コンピュータでブロック

されていないことを確認してください。

問題 CAD-BE が BIPPA サービスに接続できないことを示すポップアップ メッ

セージが表示されます。CAD-BE ログにも「CADBE1002: Could not 
connect to BIPPA service.」というメッセージが出力されています。

ソリューション BIPPA サービスが停止しているか、アクティブではない可能性がありま

す。

 冗長システムの場合は、使用する URL がスタンバイ BIPPA サービス

を参照している可能性があります。アクティブな BIPPA サービスを

使用してください。

 停止している場合は、BIPPA サービスを起動してください。
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 BIPPA サーバの CAD Configuration Setup ユーティリティをチェッ

クして、CAD-BE サーバに正しい外部表示名または IP アドレスが指

定されていることを確認してください。名前または IP アドレスは 
CAD-BE URL で使用されているものと同じでなければなりません。

CAD Configuration Setup の設定を変更した場合、その変更を有効に

するには、BIPPA サービスを再起動する必要があります。

 ポート 59012 がクライアントまたはサーバ コンピュータでブロック

されていないことを確認してください。

 非冗長システムで、LRM サービスが停止している場合は、BIPPA 
サービスがスタンバイになります。LRM サービスを再起動してくだ

さい。

 Desktop Administrator、Agent Desktop、または Supervisor 
Desktop が、CAD サービスと同じコンピュータにインストールされ

ています。これによって、BIPPA サービスで必要なレジストリ キー

（Site Setup の IOR Hostname）がクリアされます。レジストリを 
CAD サービス コンピュータのパブリック IP アドレスに設定してくだ

さい。

 CAD サーバ コンピュータのアップグレード中に、CAD-BE が実行中

でした。その結果、CAD-BE のバージョンが接続を試みた先の BIPPA 
サービスのバージョンと一致しませんでした。

 BIPPA サービスへの接続の試行中に、CAD-BE がタイムアウトしまし

た。BIPPA サーバをチェックして、CPU 負荷が高すぎないことを確

認してください。デスクトップと BIPPA サーバ コンピュータ間の

ネットワーク遅延が大きくなりすぎていないことを確認してくださ

い。

問題 CAD-BE を起動するときに、JRE プラグインのインストールが開始されま

す。

ソリューション エージェントは JRE プラグインがインストールされていないコンピュー

タで CAD-BE を実行しています。一度プラグインのインストールが完了す

ると、この動作は発生しません。JRE プラグインのインストールを完了し

てください。インストール完了後、CAD-BE が正常に起動します。

問題 CAD-BE を起動するときに、ブラウザに次のメッセージが表示されます。

「This site might require the following ActiveX control "J2SE Runtime 
Environment 5.0 Update 11" from "Sun Microsystems, Inc." Click here 
to install if you do not have the required Java Runtime Environment 
version installed.」
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ソリューション エージェントは JRE プラグインがインストールされていないコンピュー

タで CAD-BE を実行しています。ブラウザのセキュリティ設定により、ブ

ラウザが自動的に JRE プラグインをインストールできないようになって

います。正しい Internet Explorer および Firefox の設定については、

『Cisco CAD Installation Guide』を参照してください。設定を修正した

ら、CAD-BE を再起動します。

問題 CAD-BE を起動するときに、ブラウザに次のメッセージが表示されます。

「Your security settings do not allow Web sites to use ActiveX controls 
installed on your computer.This page may not display correctly.Click 
here for options if you have Java or ActiveX controls disabled in your 
browser.」

ソリューション エージェントが CAD-BE を実行しているコンピュータで、セキュリティ設

定により、ブラウザが ActiveX コンポーネントを実行できなくなっていま

す。このため JRE プラグインを実行できません。CAD-BE を実行するに

は、JRE プラグインが必要です。正しい Internet Explorer および Firefox 
の設定については、『Cisco CAD Installation Guide』を参照してくださ

い。設定を修正したら、CAD-BE を再起動します。

問題 CAD-BE を起動するときに、ブラウザに次のメッセージが表示されます。

「JavaScript is disabled in your browser.CAD-BE requires JavaScript to 
function properly.Configure your browser so that JavaScript is 
enabled, or contact your administrator for assistance.」

ソリューション Javascript がブラウザで使用可能になっていません。正しいブラウザの設

定については、『Cisco CAD Installation Guide』を参照してください。設

定を修正したら、CAD-BE を再起動します。

問題 CAD-BE を起動するときに、ブラウザに次のメッセージが表示されます。

「Your browser does not understand the object tag.CAD-BE will not 
run.」

ソリューション このメッセージは次の状況で表示されます。

 サポートされていないブラウザを使用している。このリリースでサ

ポートされているブラウザは、Internet Explorer 6 および 7、あるい

は Mozilla Firefox 1.5 以上だけです。

 必要なバージョンの JRE プラグインがインストールされていない。

CAD-BE は正しいバージョンの JRE の有効なインストール元の場所を

示すメッセージを表示します。
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 ブラウザで ActiveX コントロールが使用不能になっている。正しいブ

ラウザの設定については、『Cisco CAD Installation Guide』を参照し

てください。設定を修正したら、CAD-BE を再起動します。

 Java が使用可能になっていない。正しいブラウザの設定については、

『Cisco CAD Installation Guide』を参照してください。設定を修正し

たら、CAD-BE を再起動します。

問題 CAD-BE を起動するときに、ブラウザにポップアップがブロックされてい

ることを示すメッセージが表示されます。

ソリューション ブラウザでポップアップをブロックするように設定されています。サード

パーティ製のポップアップ ブロック機能を使用不能にします。正しいブ

ラウザの設定については、『Cisco CAD Installation Guide』を参照してく

ださい。それでもなお CAD-BE がポップアップ ブロック機能によってブ

ロックされている場合は、CAD-BE URL を選択しながら Ctrl キーを押し

て、一時的にポップアップのブロックを解除してください。

問題 CAD-BE を起動するときに、CAD-BE ウィンドウが閉じます。別の 
CAD-BE ウィンドウが表示されますが、ログイン ダイアログは表示されま

せん。

ソリューション CAD-BE がすでにデスクトップで実行しているときに、エージェントが 
CAD-BE の別のインスタンスを起動しようとしました。デスクトップで一

度に実行できる CAD-BE のインスタンスは 1 つだけです。複数のインス

タンスを起動しないでください。

問題 CAD-BE を起動するときに、空白のブラウザ ウィンドウが CAD-BE ウィ

ンドウの背面に残っています。

ソリューション スクリプトではウィンドウを閉じることができません。このウィンドウを

閉じても問題はありません。空白のウィンドウを表示しないようにするた

めの正しいブラウザ設定については、『Cisco CAD Installation Guide』を

参照してください。
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問題 エージェントがログインできません。[Login] ダイアログボックスでエー

ジェントが [OK] をクリックすると、エラー メッセージが表示され、最も

考えられる原因が 1 つ示されます。CAD-BE ログ ファイルには、

「CADBE3003: Unable to login agent.Cause <error code:error 
description>.」というメッセージのリストが表示されます。

ソリューション エラー メッセージが「Invalid agent ID/name and/or password」の場

合：

 不正なエージェント ID、名前、およびパスワードのいずれかまたは

すべてが入力されています。再度ログインしてください。エラー メッ

セージが再度表示される場合は、Unified CCX Administration でエー

ジェントのパスワードを再入力してください。

 エージェントは Unified CCX で正しく設定されていますが、同期サー

ビスによって CAD LDAP データベースと Unified CCX が同期化され

ていません。同期サービスが実行されていることを確認してくださ

い。Desktop Administrator から手動でディレクトリ サービスを同期

化してから、エージェントが Personnel ノードに存在することを確

認してください。

 Unified CCX で、エージェント ユーザ ID に対して、[Enable CTI 
Application Use] チェックボックスが選択されていることを確認して

ください。

エラー メッセージが「Invalid phone configuration」の場合：

 不正な内線番号が入力されました。再試行し、正しい情報を入力して

ください。

 電話が正しい Unified CM サーバを参照していません。

エラー メッセージが「No team found for agent」の場合：

 エージェントが Unified CCX のチームに所属していません。エー

ジェントを Unified CCX のチームに関連付けてください。

 エージェントは Unified CCX で正しく設定されていますが、同期

サービスによって CAD LDAP データベースと Unified CCX が同期

化されていません。同期サービスが実行されていることを確認して

ください。Desktop Administrator で、エージェントが存在し、正

しいチームに属していることを確認してください。

エラー メッセージが「CTI service is offline」の場合：

 CTI サービスが実行中でアクティブであることを再度確認します。

エラー メッセージが「Invalid state change」の場合：

 エージェントがアクティブなコール中にログインしてから、

「Ready」状態に変更しようとしています。コールを中止して、再

試行してください。
76 2009 年 4 月



CAD-BE に関する問題
エラー メッセージが「CTI request timeout」の場合：

 BIPPA サービス、CTI サービス、または Unified CM が遅延してい

る可能性があります。サービスの CPU の使用状況を確認してくだ

さい。

 ネットワークが遅延している可能性があります。

エラー メッセージが「LRM service is down」の場合：

 停止している場合は、LRM サービスを起動してください。

 Agent Desktop または Supervisor Desktop を CAD サービスと同

じコンピュータにインストールしました。これによって、BIPPA 
サービスで必要なレジストリ キー（Site Setup の IOR Hostname）
がクリアされます。CAD サービス コンピュータの IP アドレスにレ

ジストリを設定してください。

エラー メッセージが「No more licenses」の場合：

 数分後に再試行してください。

 1 つ以上の CAD-BE エージェントが、最初にログアウトせずに、ブ

ラウザを終了した可能性があります。このようなセッションは、ブ

ラウザの終了後 1 分間はライセンスを使用し続けます。

 1 つ以上のエージェントが Agent Desktop、CAD-BE、または IP 
Phone Agent からログアウトせずに、拡張モビリティからログアウ

トしました。これらのエージェントはまだログイン中ですが、「Not 
Ready」状態になっています。Agent Desktop はアプリケーション

が終了するまで、ライセンスを使用し続けます。BIPPA サービスが

再起動するか、エージェントが再ログインして正しい方法でログア

ウトするまで、IP Phone Agent はライセンスを使用し続けます。

エージェントがログアウトするか、CAD-BE が終了してから 1 分間

経過するまで、CAD-BE はライセンスを使用し続けます。

エラー メッセージが「Forced login failed」の場合：

 エージェントが使用するエージェント ID がすでに別の内線にログ

インしているか、エージェントが使用する内線が別のエージェント 
ID ですでにログインされています。強制ログインは同じ ID と内線

の組み合わせに対してだけ動作します。異なるエージェント ID ま
たは内線を使用するか、他のユーザを検索してこのユーザをログア

ウトさせてください。
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問題 エージェントがログインし、「Ready」状態ですが、コンピュータのスク

リーン セーバーまたは省電力機能が有効になっています。CAD-BE がフ

リーズするか、サーバから切断されます。

ソリューション これは、メモリ リークに関連する Java のバグが原因と考えられます。こ

の問題を回避するには、スクリーン セーバーおよび省電力機能を使用不

能にしてください。

問題 CAD-BE エージェントをモニタまたは録音できません。

ソリューション CAD-BE エージェントの電話が、SPAN ポート モニタリングに設定されて

いません。

問題 エージェントが [Make Call] をクリックしてコールを発信しようとする

と、Firefox ブラウザがフリーズします。

ソリューション エージェントはサポートされていないバージョンの JRE プラグインがイ

ンストールされているコンピュータで CAD-BE を実行しています。インス

トールされているプラグインのバージョンが CAD-BE に準拠しているか確

認してください。

問題 エージェントが統合ブラウザを使用しているときに、Agent Desktop が
予期せず終了します。

ソリューション 統合ブラウザで実行されている外部 Web アプリケーションが、ブラウザ

だけではなく Agent Desktop 自体も終了させる終了コマンドを発行して

いるために、このエラーが発生している可能性があります。Web アプリ

ケーションがアプリケーション全体ではなく、ブラウザ ウィンドウだけ

を終了するように、Web アプリケーションを上書きする必要があります。
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問題 エージェントが予想外にログアウトされます。

ソリューション 次の理由が考えられます。

 同じ ID または内線を持つ別のエージェントがログインしたため、最

初のエージェントがログアウトされました。

 スーパーバイザがエージェントをログアウトさせました。

 テレフォニー サービスに障害が発生しました。

 ネットワークに障害が発生しました。

問題 エージェントがブラインド会議に参加していますが、コールに参加してい

るすべての参加者を表示できません。

ソリューション CAD-BE 6.6 では、ブラインド会議は、アラート参加者を会議に追加する

機能として定義されています。Supervisor Desktop、Agent Desktop、
または CAD-BE のいずれかで、ブラインド会議に参加するすべての参加者

が表示されない場合があります。これは CTI サービス ソフトウェアの制

限事項です。

問題 エージェントが転送されたコールを受信するときに、エンタープライズ 
データが正しくありません。

ソリューション コール ウェイティングは CAD ではサポートされていません。コール ウェ

イティングが使用可能になっていると、ある特定の状況によっては、エン

タープライズ データが正しくない場合があります。たとえば、新規コー

ルがコール中のエージェントにルーティングされ、そのエージェントが最

初のコールを別のエージェントに転送した場合、最初のコールが送信され

た 2 番目のエージェントのデスクトップには、最初のコールではなく、

新規コールのエンタープライズ データが表示されることがあります。

問題 CAD-BE の [Contact Management] ペインのエンタープライズ データ部

分に何も表示されず、現在のコールに関する情報が何も表示されません。

ソリューション このエラーは、Agent Desktop エージェントがコール中にレイアウト名

を編集して存在しないレイアウトの名前を入力し、CAD-BE エージェント

にコールを転送したときに発生することがあります。この状況では、

CAD-BE の [Contact Management] ペインのエンタープライズ データ部

分は空白になります。
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問題 「Partial Service」または「No Service」メッセージが CAD-BE ステータ

ス バーに表示されます。

CAD-BE によりサービスと通信できないことが検出されると（通常、サー

ビス障害発生から 3 分以内）、サービスの一部、または全部で障害が発生

していることを示すために、メッセージ「Partial Service」または「No 
Service」が表示されます。

ソリューション ステータス バーのメッセージをダブルクリックして、[Server Status] 
ポップアップ ウィンドウを表示します。このウィンドウには、CAD-BE 機
能、およびどの機能がサービス障害による影響を受けているかがリストさ

れます。障害を起こしたサービスが再び使用可能になったことが CAD-BE 
により検出されると（通常、サービス リカバリから 1 分以内）、ステータ 
ス バーに「In Service」と表示され、サービスが回復したことが示されま

す。

問題 フェールオーバーの直後に、一部のコール履歴または一部のデータがコー

ルの [Enterprise Data] フィールドに表示されます。

症状： エージェントがコールを受信するときに、[Enterprise Data] ペイ

ンまたは [Enterprise Call History] ペイン、あるいはその両方のペイン

に、フェールオーバー前またはフェールオーバー中に開始したコールの一

部のデータが表示されません。

原因： フェールオーバー中、システムにアクティブ コールが存在してい

る可能性があります。エンタープライズ サービスは、コールのスナップ

ショットを作成して、このようなコールの情報を取得しようとします。こ

のスナップショットは完全なコール履歴を提供していません。データが欠

落しています。

ソリューション これは予想される動作です。フェールオーバー後、エンタープライズ 
サービスが作動しているときに発生したコールのデータは完全なものにな

ります。

問題 [Enterprise Data] フィールドにデータが表示されません。

症状： エージェントがコールを受信したときに、[Enterprise Data] ペイ

ンに、予想していたデータが表示されません。
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原因： Unified CCX サーバが、エンタープライズ データをエンタープライ

ズ サービスから BIPPA サービスに正しく送信していません。この状況は、

スクリプト、または Desktop Administrator の [Enterprise Data 
Configuration] セクションでステップが正しく設定されていない場合に発

生します。また、エンタープライズ データ サブシステムとエンタープラ

イズ サービスが同期されていない場合にもこのような結果になります。

ソリューション 次の手順を実行してください。

1. スクリプトおよび Desktop Administrator の [Enterprise Data 
Configuration] セクションでステップの設定を確認します。

2. エンタープライズ サービスを停止して再起動します。

3. 3. それでも問題が解決されない場合は、Unified CCX Engine を停止

して再起動します。

問題 管理者が Desktop Administrator で変更を行いましたが、変更内容が 
CAD-BE に表示されません。

ソリューション 変更を適用するには、CAD-BE エージェントはログアウトしてからブラウ

ザを再起動する必要があります。

問題 エージェントが CAD-BE を起動すると、エージェントの電話にアクティ

ブなコールがないにもかかわらず、エージェントがコール中であると

コール アピアランスが示されます。

ソリューション 起動時に、CAD-BE は CTI サービスにユーザに表示する既存の電話コー

ルのスナップショットがあるかどうかを確認します。まれに、CTI 
サービスが無効なデータを返す場合があります。無効なデータを拒否

するには、エージェントは [Drop] をクリックする必要があります。

コール アピアランスが表示され続ける場合は、エージェントは 
CAD-BE ブラウザからログアウトしてブラウザを終了し、受話器を取って

ダイヤル トーンを確認して受話器を置いてから、CAD-BE を再起動しなけ

ればならない場合があります。

問題 エージェントはスーパーバイザに緊急チャット メッセージを送信しま

したが、スーパーバイザはこのメッセージを受け取っていません。

ソリューション スーパーバイザが緊急チャット メッセージを受信できるのは、メッセー

ジを送信したエージェントが属しているチームをモニタリングしている場

合だけです。
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問題 電話会議中に、会議メンバーが <Unavailable> と表示されることがあり

ます。

ソリューション <Unavailable> は、スイッチの外部にいる参加者を表します。スイッチ

はデスクトップに外部参加者のトランク番号を送信しますが、デスク

トップではこの番号には意味がありません。CAD-BE により、トラン

ク番号は <Unavailable> に置き換えられます。

問題 使用された内線番号が Unified CME の誤ったインスタンスを示す場合で

も、エージェントが CAD-BE にログインできます。内線が呼び出される

と、発信者側ではビジー シグナルが聞こえます。また、「Ready」状態に

変更されると、エージェントに対してエラー メッセージが表示されます。

原因： Unified CME にはエージェントと内線の決まった関連付けがありま

せん。エージェントは Unified CME で「監視許可」が使用可能となって

いる任意の内線にログインできます。

ソリューション 正しい Unified CME を示す内線を使用して CAD-BE にログインしてくだ

さい。

問題 CAD-BE を起動するときに、ブラウザに次のメッセージが表示されます。

「The version of JRE installed on your PC is higher than the maximum 
version supported by CAD-BE.Uninstall all instances of JRE that have 
a version higher than the maximum version supported by CAD-BE, 
then install the version of JRE that is supplied with CAD-BE.」

ソリューション Firefox を使用している場合は、1.5 以上の JRE をすべてアンインストー

ルするか、Internet Explorer を使用してください。サポートされている 
JRE 1.5 がインストールされていることを確認してください。

問題 CAD-BE の起動時に次のエラーが表示されます。「You do not have the 
required version of the JRE plug-in installed.You can install the JRE 
plug-in from the CAD Installation webpage.」

ソリューション クライアント PC にインストールされている現在のバージョンの JRE をア

ンインストールしてから、CAD-BE を再起動してください。これにより、

互換性のあるバージョンの JRE をダウンロード可能な場所から Unified 
CCX の Web ページに移動します。
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CAD サービスに関する問題

問題 CAD サービスが実行中かどうか、どうすれば確認できますか。

ソリューション CAD システムですべてのサービスのステータスを表示する場合は、

Unified CCX Administration アプリケーションにログインします。

[System] > [Control Center] を選択します。次に、CAD サービスが配置

されているサーバを選択します。

CAD サービスが右側のパネルに表示されます。サービスの実行ステータ

スと、サービスがアクティブ（M）状態であるか、スタンバイ（S）状態

であるかどうかを確認できます。

問題 Unified CCX サービスが実行中かどうか、どうすれば確認できますか。

ソリューション Unified CCX Administration アプリケーションにログインします。

[System] > [Control Center] を選択します。次に、Unified CCX サービス

が配置されているサーバを選択します。

Unified CCX サービスが右側のパネルに表示されます。サービスの実行ス

テータスと、サービスがアクティブ（M）状態であるか、スタンバイ（S）
状態であるかどうかを確認できます。

問題 管理者が Desktop Administrator で同期を実行すると「At least one or 
more errors occurred during synchronization」というメッセージが表示

されます。

ソリューション 同期サービスのログ ファイルを確認してください。

 ログ出力されたエラーが ACMI 接続の問題を示している場合は、CTI 
サーバに関する問題を参照してください。また、エンタープライズ 
サーバ ログの類似の問題も確認してください。

 ログ出力されたエラーが LDAP エラーを示している場合は、LDAP 
サービスが実行中で、次のエントリの LDAP ホスト 1 レジストリ設定

の値が正しいことを確認してください。

HKEY_LOCAL_MACHINE¥SOFTWARE¥Spanlink¥CAD¥Site Setup
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問題 Tomcat Web サーバが正しくインストールされているかどうか、どうすれ

ば確認できますか。

ソリューション 次のテストを実行します。

 Unified CCX Administration にログインします。[System] > [Control 
Center] を選択します。次に、Unified CCX サービスが配置されてい

るサーバを選択します。Unified CCX Administration が実行中である

ことを確認します。

 BIPPA サービスがインストールされている PC で、[Services] コント

ロール パネルをチェックして、BIPPA サービスが実行中であるかど

うかを確認します。

 Web ブラウザのアドレス欄に次の URL を入力します。ここでは 
<Tomcat> は Tomcat がインストールされているサーバの IP アドレ

スです。

http://<Tomcat>:6293/ipphone/jsp/sciphonexml/

IPAgentInitial.jsp

これらのテストに失敗した場合、次の点を確認してください。

 JRE がサーバにインストールされている。

 JSP ページの URL を正しい java サーブレットにマッピングするため
のファイルである web.xml は C:¥Program Files¥wfavvid¥tomcat_
appadmin¥webapps¥ipphone¥web-inf ディレクトリになければな
りません。

 次のエントリをレジストリで検索します。

HKEY_LOCAL_MACHINE¥SOFTWARE¥Spanlink¥CAD¥IPPA¥
Config¥TOMCAT HOME

[Edit] > [Modify] の順に選択してから、[Value data] フィールドに 
C:¥Program Files¥wfavvid¥ tomcat_appadmin¥ と入力します。
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チャットに関する問題

問題 電話会議の終了後、チャット クライアントと Supervisor Desktop に別の

参加者とのコールが表示されます。

ソリューション 各エージェントは CTI サーバから異なるデータを受信する場合がありま

す。たとえば、お客様（555-5555）がエージェント A にコールします。

すると、CTI サーバは 555-5555 を呼び出し番号としてエージェント A 
に報告します。次に、エージェント A はエージェント B と会議をします。

ただし、この場合の CTI サーバはエージェント B に対し、カスタマー番

号として <Unavailable> と報告します。2 人のエージェント（エージェ

ント A とエージェント B）、カスタマー番号、および <Unavailable> の
データをマージするときに、カスタマー番号と <Unavailable> を識別で

きないため、別の参加者が追加されます。
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コール / チャット サービスに関する問題

問題 コール / チャット サービスを開始しようとすると、次のエラーが発生し

ます。

Could not start the Call/Chat Service on ¥¥<computer> 
Error 2140: An internal Windows error occurred.

ソリューション Windows イベント ログを見て、サービスの起動に失敗した理由を確認し

ます。

1. [Start] > [Programs] > [Administrative Tools] > [Event Viewer] を選

択します。

2. ツリー コントロールから [Application] を選択します。

3. ソースとして FCCServer（コール / チャット サービス）を表示する

メッセージを検索します。これらのメッセージはエラーの原因に関す

る詳細を示しているはずです。

問題 コール / チャット サービス、および LDAP モニタ サービスが実行中かど

うか、どうすれば確認できますか。

ソリューション CAD サービスがインストールされている PC で [Services] コントロール 
パネルを開きます。次の 2 つのサービスが一覧に表示されるはずです。

 Cisco Desktop Call/Chat Service

 Cisco Desktop LDAP Monitor Service

いずれかのサービスのステータスが [Started] ではない場合は、サービス

を選択して、[Start] をクリックします。
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問題 Desktop Administrator コンフィギュレーション ファイルをネットワー

ク ドライブにインストールしようとすると、次のエラーが表示されます。

「The drive does not support long file names.You must choose a drive 
that support long file names.See your network administrator for more 
information.」

ソリューション ネットワーク ドライブで長いファイル名のサポートを使用可能にするか、

長いファイル名をサポートする別のドライブを選択する必要があります。

また、管理者の PC にコンフィギュレーション ファイルをインストールす

ることもできます。管理者の PC にコンフィギュレーション ファイルをイ

ンストールする場合は、ファイル共有を使用可能にしてください。

問題 管理者が新しいワークフロー グループを作成できません。

ソリューション このワークフロー グループ名がすでに別のグループに使用されているか、

ワークフロー グループ名が有効な Windows ディレクトリ名ではありませ

ん。

問題 [Contact List] ページから専門分野のエキスパートを検索しているときに、

名前が見つからず、次のエラー メッセージが表示されます。

「CDAUI2067 search did not complete successfully, and only partial 
results are displayed.Contact technical support.」

ソリューション このエラーは、[Unified Presence Cluster Settings] ページのパラメータ

設定が正しくない場合に発生します。この問題の原因は 2 つあると考え

られます。ユーザの認証資格情報が正しくないか、ホスト名または IP ア
ドレスが正しくないか、です。

（注）[Cisco Unified Presence Cluster Settings] ページで指定さ

れているユーザは、SOAP クエリーを実行でき、エージェントが

関連付けられているものと同じ LDAP プロファイルに関連付けら

れていなければなりません。

この問題を診断して解決するには、次の手順を実行してください。

1. [Cisco Unified Presence Settings] > [Cisco Unified Presence 
Cluster Settings] を選択します。
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2. [Verify] をクリックします。

 ホスト名または IP アドレスが正しくない場合には、

「CDAUI2033 Error communicating with the Unified Presence 
Server.」というエラー メッセージが表示されます。

 ユーザ認証資格情報が正しくない場合には、「CDAUI2034 
Invalid Cisco Unified Presence Cluster user 
credentials.Configured user must be able to run SOAP 
queries.」というエラー メッセージが表示されます。

3. 該当するフィールドに正しい情報を入力してから、[Verify] をクリッ

クして、入力した情報をテストします。トランザクションが成功した

ことを示すメッセージが表示されます。

4. [Save] をクリックします。

問題 SME は Cisco Unified Personal Communicator にログインできますが、

自分自身のプレゼンス ステータスを設定できません。または、コンタク

トのプレゼンス ステータスを表示できません。Unified Personal 
Communicator ログ ファイルには「401 (Unauthorized).」というエラー 
メッセージも出力されています。

ソリューション このエラーは、Unified Presence の着信 Access Control List（ACL; アク

セス コントロール リスト）が正しく設定されていない場合に発生します。

ACL を使用すると、Unified Presence にアクセスできるホストおよびド

メインを制御するパターンを設定できます。SME が Unified Personal 
Communicator から Unified Presence にアクセスできるようにするに

は、「all」のエントリを着信 ACL に追加する必要があります。

「all」エントリを着信 ACL として追加するには、次の手順を実行します。

1. Unified Presence Administration にログインします。

2. [System] > [Security] > [Incoming ACL] を選択します。[Find and 
List Allowed Incoming Hosts] ページが表示されます。

3. [Add New] をクリックします。[Incoming Access Control List 
Configuration] ページが表示されます。

4. 必要に応じて、アドレス パターンの説明を [Description] フィールド

に入力します。

5. [Address Pattern] フィールドに「all」と入力して、[Save] をクリッ

クします。
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問題 Agent Desktop を実行しているエージェントから表示した場合、ソフト 
IP フォンを使用している専門分野のエキスパートが電話機上に表示され

ません。

ソリューション Unified CM Session Initiation Protocol（SIP）発行トランクが正しく設

定されていません。

Unified CM SIP 発行トランクが正しく設定されていることを確認するに

は、次の手順を実行します。

1. Unified Presence Administration にログインします。

2. [Presence] > [Settings] を選択します。[Cisco Unified Presence 
Settings] ページが表示されます。

3. 正しいトランクが [CUCM SIP Publish Trunk] ドロップダウン リスト

で選択されていることを確認します。

（注）[Enable SIP Publish on CUCM] チェックボックスを選択し

て [CUCM SIP Publish Trunk] パラメータを有効にする必要があ

ります。

Unified CM の SIP トランクの詳細については、『Cisco Unified 
Communications Solution Reference Network Design (SRND) for 
Cisco Unified Communications Manager』を参照してください。

問題 Unified Personal Communicator を実行している別の専門分野のエキス

パートから表示した場合、ソフト IP フォンを使用している専門分野のエ

キスパートが通話中と表示されません。

ソリューション Unified CM Session Initiation Protocol（SIP）発行トランクが正しく設

定されていません。

Unified CM SIP 発行トランクが正しく設定されていることを確認するに

は、次の手順を実行します。

1. Unified Presence Administration にログインします。

2. [Presence] > [Settings] を選択します。[Cisco Unified Presences 
Settings] ページが表示されます。

3. 正しいトランクが [CUCM SIP Publish Trunk] ドロップダウン リスト

で選択されていることを確認します。
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（注）[Enable SIP Publish on CUCM] チェックボックスを選択し

て [CUCM SIP Publish Trunk] パラメータを有効にする必要があ

ります。

Unified CM の SIP トランクの詳細については、『Cisco Unified 
Communications Solution Reference Network Design (SRND) for 
Cisco Unified Communications Manager』を参照してください。

問題 エージェントに SME が表示されません。

ソリューション 次の確認を行います。

 エージェントが Cisco Unified Personal Communicator にアクセス

している場合、エージェントが Unified Personal Communicator に
ログインして SME が表示できるかを確認します。

 Desktop Administrator で、[Cluster Configuration] ページの 
Unified Presence サーバの正しい IP アドレスが有効であるかを 
[Verify] をクリックして確認します。

 1 つ以上の SME を含んでいる少なくとも 1 つのコンタクト リスト

が、エージェントが所属するワークフロー グループに割り当てられて

いることを確認します。

 エージェントが Agent Desktop を実行して Unified Presence にログ

インしていることを確認します。ログインするには、[Chat] をクリッ

クし、[File] > [Log In] を選択します。

[File] > [Log In] のメニュー オプションは、エージェントが Unified 
Presence をログアウトしてサーバが実行中のときにだけ有効になり

ます。この状況が発生するのは、（1）エージェントの Unified 
Presence のユーザ名またはパスワードが CAD のユーザ名またはパス

ワードと異なる場合、および（2）エージェントが [Login] ダイアロ

グボックスの [Cancel] をクリックした場合に限ります。

エージェントがすでに Unified Presence にログインしている場合は、

[Log In] メニュー オプションは無効になります。Unified Presence 
サーバが停止している場合は、サーバが起動したときに自動的にエー

ジェントをログインさせようとするため、このオプションは使用可能

になりません。自動ログインに失敗した場合はログイン ダイアログ

ボックスが表示され、エージェントがキャンセルするとこのオプショ

ンは使用可能になります。
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問題 SME がエージェントを表示できないか、エージェントの状態が不明です。

ソリューション 次の確認を行います。

 エージェントが SME のコンタクトまたはバディ リストに含まれてい

ることを確認します。

 ワークフロー グループがエージェントの状態を発行するように設定さ

れていることを確認します。

問題 エージェントまたはスーパーバイザが Agent Desktop または Supervisor 
Desktop にログインすると、入力されたログインが Unified Presence に
対して有効でないことを示すエラー メッセージが表示されます。

ソリューション Agent Desktop および Supervisor Desktop は、Unified Presence にロ

グインするときに、デスクトップ アプリケーションのログインに使用さ

れた資格と同じ資格を自動的に使用しようとします。Unified Presence 
資格が異なる場合、エージェントまたはスーパーバイザは、手動で資格を

入力する必要があります。別の方法として、Agent Desktop または 
Supervisor Desktop の場合と同じ資格を Unified Presence サーバに使

用することもできます。

問題 [Actions] メニューのコール制御オプションがアクティブでないため、

エージェントが SME へのコールを [Contact Selection] ウィンドウで開

始できません。

ソリューション Agent Desktop が SME の電話番号を Unified Presence から取得できて

いません。Unified Presence の SME に電話番号が設定されていることを

確認してください。Unified Presence に関連付けられている Active 
Directory に電話番号が記載されています。

問題 SME がすでにコール中の場合でも、[Contact Selection] ウィンドウで 
SME のプレゼンス ステータスが [Available] と表示されます。

ソリューション Unified Presence が、SME の電話ステータスをモニタするように設定さ

れていません。

電話ステータスをモニタするように Unified Presence を設定するには、

次の手順を実行します。

1. Unified CM Administration にログインします。
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2. [Device] > [Trunk] を選択します。[Find and List Trunks] ページが表

示されます。

3. SIP Trunk タイプのトランクがあり、トランクの宛先アドレスが 
Unified Presence サーバの IP アドレスであることを確認します。

4. [Device] > [Phone] を選択します。[Find and List Phones] ページが

表示されます。

5. SME の Unified Personal Communicator に対応するデバイスを検出

して、そのハイパーリンクをクリックします。[Phone 
Configuration] ページが表示されます。

6. SME のデバイスに設定されているディレクトリ番号のハイパーリン

クをクリックします。[Directory Number Configuration] ページが表

示されます。

7. [Users Associated with Line] セクションで、[Associate End Users] 
をクリックします。[Find and List Users] ページが表示されます。

8. SME のデバイスに設定されているディレクトリ番号に関連付ける

ユーザを選択して、[Add Selected] をクリックします。[Directory 
Number Configuration] ページが表示され、このディレクトリ番号に

関連付けたユーザが表示されます。

9. [Save] をクリックして変更を保存します。

10. Unified Presence Administration にログインします。

11. [Presence] > [Settings] を選択します。[Cisco Unified Presence 
Settings] ページが表示されます。

12. CUCM SIP Publish Trunk が Unified CM に設定した（上記の手順 3）
SIP トランクと同じであることを確認します。

問題 エージェントがチャット メッセージを受信しません。

ソリューション このエラーは、エージェントが 2 つのアプリケーションを介して Unified 
Presence にログインしているときに発生します。エージェントは、異な

るユーザ名を使用しても、Unified Personal Communicator および 
Agent Desktop/Supervisor Desktop を同時に介して Unified Presence 
にログインできません。
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問題 エージェントが転送コールを受信したときのエンタープライズ データが

正しくありません。

ソリューション コール ウェイティングは CAD ではサポートされていません。コール ウェ

イティングが使用可能になっていると、ある特定の状況によっては、エン

タープライズ データが正しくない場合があります。たとえば、新規コー

ルがコール中のエージェントにルーティングされ、そのエージェントが最

初のコールを別のエージェントに転送した場合、最初のコールが送信され

た 2 番目のエージェントのデスクトップには、最初のコールではなく、

新規コールのエンタープライズ データが表示されることがあります。

問題 Agent Desktop の [Contact Management] ペインのエンタープライズ 
データ部分に何も表示されず、現在のコールに関する情報が何も表示され

ません。

ソリューション このエラーは、1 人のエージェントがコール中にレイアウト名を編集して

存在しないレイアウトの名前を入力し、別のエージェントにコールを転送

したときに発生することがあります。この状況では、2 番目のエージェン

トのデスクトップの [Contact Management] ペインのエンタープライズ 
データ部分は空白になります。

問題 管理者が Desktop Administrator からマクロを記録できません。

ソリューション 一部のウィルス チェック ソフトウェアによって、マクロ レコーダが実行

できなくなっている可能性があります。管理者の PC のウィルス チェック 
ソフトウェアをすべて無効にします。

問題 [Save] ボタンが無効になっているため、管理者が Desktop Administrator 
で行った変更を保存できません。

ソリューション 別のユーザが同じサーバの Desktop Administrator に先にログインして

います。Web アプリケーションが、その最初のユーザを除くすべての

ユーザに対してロックされています。別のユーザが変更を保存できるよう

にするには、次の操作を行う必要があります。

 最初のユーザがログアウトします。

 最初のユーザのセッションは、Desktop Administrator が自動的にタ

イムアウトした後、15 分間だけ非アクティブになります。
2009 年 4 月 93



Cisco CAD トラブルシューティング ガイド
 最初のユーザはログアウトせずに Web ブラウザを閉じます。その場

合、Desktop Administrator はすべてのユーザに対して 15 分間ロッ

クされます。

 最初のユーザがログアウトせずに Desktop Administrator での操作を

終了します。最初のユーザが 15 分以内に Desktop Administrator に
戻る場合は、そのユーザはまだログインしており、変更を行えます。

最初のユーザが 15 分以内に Desktop Administrator に戻らない場合

は、15 分後にそのユーザがログアウトすると別のユーザは変更を行

えます。
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デスクトップ ワークフロー管理者に関する
問題

問題 管理者がワークフロー セットアップでいくつかの変更を行い、その変更

をキャンセルすることにしました。しかし、それらはすでに保存されてい

ました。

ソリューション 新しい処理を作成すると、どの変更も [Select Action] ダイアログボック

スに戻る前に自動的に保存されます。

問題 管理者が内部の内線番号に従ったルールを取得できません。

ソリューション Agent Desktop が電話番号を比較するときは、ダイヤル ストリング番号

形式に先頭の x が含まれていると、そのリストの電話番号にも先頭の x が
含まれている必要があります。

問題 外部アプリケーションを起動する処理が正しく動作していません。

ソリューション ディレクトリ名およびファイル名にスペースがある場合、オペレーティン

グ システムが認識できないことがあります。C:¥Program 
Files¥Acme¥Search Database.exe /t/x のようなアプリケーションがあ

る場合、ディレクトリと実行可能ファイルを囲む引用符を追加する必要が

ある場合があります。たとえば上記の場合、"C:¥Program 
Files¥Acme¥Search Database.exe" /t/x のようにします。

問題 Agent Desktop が外部アプリケーションを起動しようとすると、次のエ

ラーメッセージが表示されます。「Error Launching Application...The 
system cannot find the file specified.」

ソリューション 外部アプリケーションの起動処理を作成する場合、起動するアプリケー

ションの拡張子を含める必要があります。たとえば、Windows のメモ帳

を起動する場合、C:¥Windows¥Notepad ではなく、

C:¥Windows¥Notepad.exe と指定する必要があります。

実行可能ファイルへのパスまたは引数にスペースが含まれる場合は、たと

えば、"C:¥Program Files¥MyFile.doc" のように、引用符で囲まなければ

なりません。
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問題 管理者が E メール メッセージを送信するタスク ボタンを設定し、ヒント

を Send E-mail（Ctrl+S）に変更しましたが、ショートカット キーが機

能しません。

ソリューション タスク ボタンでは、ヒント テキストだけを変更できます。ショートカッ

ト キーは変更できません。

問題 デバイスの応答が十分な速さでないため、ワークフロー処理のルート ポ
イントまたはルート ポートまでの自動ブラインド転送が失敗しています。

ソリューション ブラインド転送が実行される前のワークフロー処理に遅延時間を加えて、

デバイスの準備ができ、動作が正常に完了するようにします。

問題 使用された内線番号が Unified CME の誤ったインスタンスを示す場合で

も、エージェントが Agent Desktop にログインできます。内線が呼び出

されると、発信者側ではビジー シグナルが聞こえます。また、「Ready」
状態に変更されると、エージェントに対してエラー メッセージが表示さ

れます。

原因： Unified CME にはエージェントと内線の決まった関連付けがありま

せん。エージェントは Unified CME で「監視許可」が使用可能となって

いる任意の内線にログインできます。

ソリューション 正しい Unified CME を示す内線を使用して Agent Desktop にログインし

てください。
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エンタープライズ データに関する問題

問題 エンタープライズ データがアウトバウンド コールのデータを表示しませ

ん。

ソリューション エンタープライズ データは、インバウンド コールのデータだけを表示し

ます。

問題 エンタープライズ データがインバウンド コールのデータを表示しません。

ソリューション コールが通過するデバイスはすべて、モニタされるデバイスのリスト

（Desktop Administrator では、[Enterprise Data Configuration] をク

リック）上にある必要があります。そうしないとデータは表示されませ

ん。エンタープライズ サービスが正しくインストールされて実行されて

いることを確認します。すべてが正しく稼動しているように見える場合

は、エンタープライズ サービスがインストールされている PC をリブート

してみます。PC がリブートされたら、エージェントのデスクトップ上の 
Agent Desktop を再起動します。

問題 エンタープライズ データがコールの拒否後にデータを表示します。

ソリューション エンタープライズ データは、最後のコールから新しいコールが受信され

るまでのデータを表示します。これにより、エージェントは事後処理のエ

ンタープライズ データを使用できます。
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エンタープライズ サービスに関する問題

問題 エンタープライズ サービスが完全にインストールされているかどうか、

どうすれば確認できますか。

ソリューション [Services] コントロール パネルを開きます。次の 2 つのサービスが一覧

に表示されるはずです。

 Cisco Desktop LDAP Monitor Service

 Cisco Desktop Enterprise Service

これらのサービスが示されてない場合は、エンタープライズ サービスを

再インストールしてください。

問題 LDAP モニタ サービスが実行中かどうか、どうすれば確認できますか。

ソリューション [Services] コントロール パネルを開きます。LDAP モニタ サービスのス

テータスを確認します。ステータスが Started でない場合は、サービスを

選択し、[Start] をクリックします。

問題 エンタープライズ サービスが実行中かどうか、どうすれば確認できます

か。

ソリューション [Services] コントロール パネルを開きます。エンタープライズ サービス

のステータスを確認します。ステータスが Started でない場合は、サービ

スを選択し、[Start] をクリックします。

問題 ユーザがエンタープライズ サービスを起動しようとすると、次のエラー

が表示されます。

Could not start the Cisco Enterprise Service on ¥¥<computer>
Error 2140: An internal Windows error occurred.

ソリューション Windows イベント ログを見て、サービスの起動に失敗した理由を確認し

ます。

1. [Start] > [Programs] > [Administrative Tools] > [Event Viewer] を選

択します。
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2. [Log] メニューで [Application] を選択します。

3. Enterprise サーバを発信元として表示するメッセージを選択します。

これにより、障害の原因に関する詳細情報が提供されます。

問題 ユーザがデバイスとの間で発着信コールを行う際、ポップアップ画面が表

示されません。

ソリューション 次の操作を試行してください。

 Enterprise Administrator を使用して、デバイスがモニタされている

ことを確認します。

 CTI サーバが実行中かどうかを確認します。

 エージェントがデバイスにログインしているかどうかを確認します。

 Unified CCX にデバイスが設定されているかどうかを確認します。

問題 ユーザが特定のデバイスを呼び出しても何も起こりません。

ソリューション 次の操作を試行してください。

 デバイスがモニタされていることを確認します。

 イベント ログを確認し、デバイスのエラー メッセージがあるかどう

かを確認します。

問題 エージェントがコールを受信したときに不完全なエンタープライズ デー

タが表示されたり、エンタープライズ データがまったく表示されなかっ

たりします。

ソリューション 次の操作を試行してください。

 エンタープライズ サービスでデバイスがモニタされているかどうかを

確認します。

 デバッグしきい値を DEBUG に設定します。Agent Desktop を停止

し、再起動します。コール シナリオを繰り返し、ssctihandler.dbg 
に非監視デバイスに関する警告がないかを確認します。デバッグ ファ

イル内で「monitoring」を検索します。
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問題 ユーザがエンタープライズ サービスを起動しようとすると、次のエラー

が表示されます。

Could not start the Cisco Desktop Enterprise Service on ¥¥<computer>
Error 2140: An internal Windows error occurred.

ソリューション Windows イベント ログを見て、サービスの起動に失敗した理由を確認し

ます。

1. [Start] > [Programs] > [Administrative Tools] > [Event Viewer] を選

択します。

2. [Log] メニューで [Application] を選択します。

3. Enterprise サーバを発信元として表示するメッセージを選択します。

これにより、障害の原因に関する詳細情報が提供されます。
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インストールに関する問題

問題 Agent Desktop サービスは、バージョン 6.4（1）からバージョン 6.6
（1）にアップグレードされて、自動アップデートが有効になっています。

Agent Desktop アプリケーションは、次に起動されるときに自動的に更

新されるはずです。しかし、一部のデスクトップはそのようにアップグ

レードされないため、コンタクト センターで動作している Agent 
Desktop に、異なるバージョンが混在しています。

ソリューション 自動的にアップグレードされてないデスクトップは、Unified CCX 
Administration Web アプリケーションから個別にアップグレードする必

要があります。詳細については、『Cisco CAD Installation Guide』を参照

してください。
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IP Phone Agent に関する問題

問題 エージェントに対して、IP Phone Agent サービスがアクティブでないエ

ラー メッセージが表示されます。

ソリューション ソリューションをいくつか示します。

 非冗長システムで、LRM サービスが停止している場合は、BIPPA 
サービスがスタンバイになります。LRM サービスを再起動してくだ

さい。

 Agent Desktop または Supervisor Desktop を CAD サービスと同じ

コンピュータにインストールしました。これによって、BIPPA サービ

スで必要なレジストリ キー（Site Setup の IOR Hostname）がクリ

アされます。CAD サービス コンピュータの IP アドレスにレジストリ

を設定してください。

問題 エージェントがログインしようとすると [Force Login] が表示されますが、

強制ログインを実行しようとすると失敗します。

ソリューション エージェントが使用するエージェント ID がすでに別の内線にログインし

ているか、エージェントが使用する内線が別のエージェント ID ですでに

ログインされています。強制ログインは同じ ID と内線の組み合わせに対

してだけ動作します。異なるエージェント ID または内線を使用するか、

他のユーザを検索してこのユーザをログアウトさせてください。

問題 意味のないエンタープライズ データ、理由コードまたはラップアップ 
データがエージェントに表示されます。

ソリューション Desktop Workflow Administrator で設定される理由コードまたはラップ

アップ データに、電話でサポートされていない文字が使用されています。

たとえば、マルチバイトの中国語や漢字文字です。理由コードおよびラッ

プアップ データを設定するときに、サポートされていない文字を使用し

ないようにします。
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問題 スーパーバイザが IP Phone Agent エージェントを録音またはモニタでき

ません。

ソリューション VoIP モニタリングと録音に関するトラブルシューティング情報について

は、『Configuring and Troubleshooting VoIP Monitoring』を参照してく

ださい。
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LDAP モニタに関する問題

問題 LDAP モニタ サービスは実行していますが、Slapd.exe が実行されませ

ん。

ソリューション 次の手順を実行してください。

 C:¥Program Files¥Cisco¥Desktop¥config フォルダの slapd.cfg 
ファイル内の設定を確認します。

 slapd.exe の他のインスタンスが実行中でないことを確認します。

 C:¥Program Files¥Cisco¥Desktop¥database フォルダに拡張子 
*.dat を持つ 7 つのファイルと DB_CONFIG が含まれていることを確

認します。これらのファイルがない場合、別のシステムからコピーす

るか、CAD サービスを再インストールします。

 C:¥Program Files¥Cisco¥Desktop¥database フォルダに、log.*、
__db.*、および *.bdb 拡張子を持つ 8 つのファイルが含まれている

ことを確認します。これらのファイルがない場合、「同期されていな

いディレクトリ サービス データベース」 （P.43）の手順に従って、

正常に機能しているものからコピーします。または、CAD サービスを

再インストールする必要があります。

 次の手順を実行して、slapd.exe が起動できない理由に関する詳細を

取得します。

a. LDAP モニタ サービスを停止します。

b. DOS コマンド ウィンドウを開いて、フォルダ 
C:¥Program Files¥Cisco¥Desktop¥bin にナビゲートします。

c. slapd.exe -f slapd.cfg と入力して、Enter を押します。

d. 異常終了した場合は、結果のエラー メッセージを使用して問題を

診断します。

e. 正常に成功した場合は、Ctrl+C キーを押して終了します。

f. C:¥Program Files¥Cisco¥Desktop¥config フォルダの 
LDAPMonSvr.cfg ファイル内の設定に、slapd.exe の引数が含ま

れていることを確認します。
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問題 クライアントが LDAP サービスに接続できません。

ソリューション ソリューションをいくつか示します。

 レジストリの LDAP Host 1 または LDAP Host 2、あるいはこれら両

方に設定されている IP アドレスが間違っています。

 LDAP モニタ サービスが実行されていません。サービスを起動してく

ださい。

 slapd.exe が実行されているか確認してください。実行されていない

場合は、この問題のトラブルシューティング手順に従ってください。

 LDAP データベースが破損しています。「破損したディレクトリ サー

ビス データベース」 （P.42）で説明されている手順に従ってくださ

い。

問題 クライアントが LDAP 間でフェールオーバーを行うと、LDAP から同じ

データを検索できなくなります。

ソリューション ソリューションをいくつか示します。

 複製が正しくセットアップされていることを確認します。

 両方の CAD サービス コンピュータで LDAP Host 1 および 2 のレジ

ストリ エントリをチェックして、これらが同じで、その情報が正しい

ことを確認します。

 両方の CAD サービス コンピュータの slapd.conf が正しく、相互に

参照しているか確認します。

 上記の方法でも問題が解決しない場合は、「同期されていないディレ

クトリ サービス データベース」 （P.43）の手順に従います。

問題 複製をセットアップするとき、LDAP データベースを含む 1 つ以上のファ

イルがサイド A からサイド B にコピーされません。

ソリューション サイド A の LDAP データベースを構成する 1 つ以上のファイルは、サイ

ド B に完全にコピーされません。ユーザは次のことを確認できます。

 サイド A に障害（または再起動）が発生してクライアントがサイド B 
にフェールオーバーすると、slapd が実行されているように見えて

も、ユーザは LDAP に接続できません。
2009 年 4 月 105



Cisco CAD トラブルシューティング ガイド
 LdapMonSvr のログ ファイル内に、次の行が見つかります。

Failed to send file

これを自分で修正しようとしないでください。テクニカルサポートに連絡

してください（テクニカルサポート：/S オプションを付けた LdapUtil を
使用して複製をセットアップします）。
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録音と統計サービスに関する問題

問題 エージェント状態またはコール ログを表示しようとしても、データが表

示されません。

ソリューション エージェントがコールを受信していないか、またはその特定の日にログイ

ンしてない可能性があります。エージェントまたはスーパーバイザの PC 
のクロックが正しいタイム ゾーンにない可能性があります。

（注）すべての状態とコール時刻はサーバ時刻を基準にしていま

す。

問題 Agent Desktop、Supervisor Desktop のログとレポート、または 
Supervisor Record Viewer で、データが正しい時系列の順番に表示され

ません。Unified CCX が冗長構成になっており、フェールオーバーが発生

しました。

ソリューション 冗長 Unified CCX サーバのシステム クロックが同期化されてない場合、

あるサーバから別のサーバへのフェールオーバー後にレポート データと

ログ データは正しい順序で表示されなくなります。この状況を改善する

には、ネットワーク時刻サービスを使用してすべてのサーバのシステム 
クロックを自動的に同期化するか、または手動で調整してそれらを同期化

します。
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録音とモニタリングに関する問題

VoIP モニタリングと録音に関するトラブルシューティング情報については、

『Configuring and Troubleshooting VoIP Monitoring』を参照してください。
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Supervisor Desktop に関する問題

問題 [Team View] ペインでスキルを選択しようとするときのエラー。

症状： Supervisor Desktop の [Team View] ペインでスキルを選択しよう

とすると、次のメッセージが表示されます。

メッセージ： コール割り込み、通話録音、および待ち状態が使用可能にな

る前に Agent Desktop をアクティブにする必要があります。

原因： スキル グループ統計情報を表示するには、スーパーバイザ ログイ

ンを使用して Agent Desktop にログインする必要があります。

ソリューション スーパーバイザ ログインを使用して Agent Desktop にログインしてくだ

さい。

問題 Supervisor Desktop 内のエージェントの表示。

症状： Supervisor Desktop 内のエージェントの表示に関連する次の症状

が発生する場合があります。

 Supervisor Desktop からエージェントが消える。

 Supervisor Desktop にエージェントが示されない。

 Supervisor Desktop にエージェントがまったく表示されない。

原因： エージェントと Unified CCX システムの間、または Unified CCX 
system とスーパーバイザとの間の誤設定や IP 接続上の問題。

ソリューション 次の手順を実行してください。

1. スーパーバイザがモニタしているチームにエージェントが所属してい

ることを確認します。『Cisco Desktop Administrator User Guide』
に記述されている、チーム設定に関するセクションを参照してくださ

い。

2. Agent Desktop および Supervisor Desktop のすべてのインスタンス

が、Unified CCX サーバ上で実行している CAD サービスと同じバー

ジョンにアップグレードされていることを確認します。

3. スーパーバイザの PC またはエージェントの PC に複数の NIC が装着

されているかどうかを確認します。

4. ファイアウォールによって 59000 ～ 59030 の範囲にあるポートが

ブロックされているかどうかを確認します。
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5. [Local Area Connection settings] > [Advanced] タブにより、

Windows XP が稼動しているエージェントの PC またはスーパーバイ

ザの PC が Internet Connection Firewall（ICF; インターネット接続

ファイアウォール）を有効にしたことを確認します。

6. ブロックされているポートがあるかテストするには、エージェントと

スーパーバイザがログインした状態で次のようにコマンドラインから 
Telnet を使用します。

 チャット サービスからエージェントに次のコマンドを入力しま

す。
telnet <agent PC IP address> 59020

 チャット サービスからスーパーバイザに次のコマンドを入力しま

す。
telnet <supervisor PC IP address> 59021

 エージェントからチャット サービスに次のコマンドを入力しま

す。
telnet <Unified CCX server IP address> 59000

「接続失敗」エラーが表示された場合はポートがブロックされた原
因を特定する必要があります。

問題 何らかの理由でエージェントの状態が Not Ready に変化します。

症状： 状況によって、何らかの理由でエージェントの状態が Not Ready 
に変化する場合があります。

原因： 理由を特定するには、理由コードを確認します。

 理由コードが 32763 である場合、エージェントの状態は Ring No 
Answer（RNA; 応答なし）のため Not Ready になります。Unified 
CM でエージェントの電話が自動応答を有効に設定されている場合、

コールがすぐに応答されないため、これは Unified CM の問題の可能

性があります。Unified CM サポートに相談してください。

 理由コードが 32759 である場合、エージェントの状態は 電話がアウ

ト オブ サービスになったため Not Ready になります。電話機がまだ

機能していて電話を直接コールできるか確認します。すべてに問題が

ないように思われる場合は、一時的な問題である場合がほとんであ

り、電話機は復旧します。電話機がまだ復旧しない場合は、Unified 
CM の問題である場合がほとんどです。Unified CM サポートに相談

してください。

 理由コードが 32757 である場合、Unified CM フェールオーバーによ

る phone rehomed のため、エージェントの状態は Not Ready にな

ります。フェールオーバーの後にエージェントが Ready に移行でき

る限り、これは問題になりません。
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ソリューション 多くの場合、エージェントの状態が Not Ready になることは重大な問題

ではありません。[Ready] をクリックするだけで、エージェントの状態を 
Ready に変更できます。

理由コードを確認するには、次のいずれかを実行します。

 Agent State Report を開きます。Agent Desktop から、[Reports] を
クリックします。[Agent IPCC Express State Log] を選択します。

エージェントの状態が Not Ready になったときに「Not Ready」と

表示されるエントリを探します。このエントリの理由コードを確認し

ます。

 Agent State Detail Report および Unified CCX Historical Report を
実行し、エージェントが「Not Ready」状態になったときに、エー

ジェントの「Not Ready」エントリを探します。このエントリの理由

コードを確認します。

電話機にまだ障害があるためエージェントが状態を Ready に変更できな

い状況の場合は、Unified CM サポートに連絡してください。

問題 VPN を通してコンタクト センターに接続するエージェントが、

[Supervisor Desktop Team View] ペインに表示されません。VPN を切断

して再接続した後、[Team View] ペインからエージェントが消えました。

ステータス バーには「In Service」と表示されています。

ソリューション エージェントとスーパーバイザのいずれかが VPN 接続を使用する場合は、

それらのデスクトップを、VPN を切断して再接続した後に再起動する必

要があります。

問題 Windows XP を使用するスーパーバイザは Supervisor Desktop を使用す

ることができましたが、チームをロードできないか、任意のエージェント

情報を表示できませんでした。

ソリューション Windows XP は、インターネット接続ファイアウォール（ICF）がアク

ティブになるように設定できます。ICF は、コンピュータとの間のトラ

フィックをすべて追跡し、特定のコンピュータから発信された情報だけを

通過させます。このコンピュータ以外のところから発信されたメッセージ

は、破棄されます。

この問題を解決するには、ICF をオフにする（コンピュータの管理者権限

を持つ人に依頼する）か、またはデフォルトを Agent Desktop サーバの

ような既知の「良好な」接続を含むように上書きします。
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問題 スーパーバイザがエージェントをクリックしてモニタリングを開始する

と、Supervisor Desktop はコールの横にあるスピーカ アイコンを表示し

ますが、音は出ません。

ソリューション VoIP モニタリングと録音に関するトラブルシューティング情報について

は、『Configuring and Troubleshooting VoIP Monitoring』を参照してく

ださい。

問題 スーパーバイザが VoIP モニタ サービスにログインできず、エラー

「Could not access sound card」を受信します。

ソリューション VoIP モニタリングと録音に関するトラブルシューティング情報について

は、『Configuring and Troubleshooting VoIP Monitoring』を参照してく

ださい。

問題 サウンド品質が悪く、モーターボートの音のように途切れがちになりま

す。

ソリューション VoIP モニタリングと録音に関するトラブルシューティング情報について

は、『Configuring and Troubleshooting VoIP Monitoring』を参照してく

ださい。

問題 音の遅延が発生します。スーパーバイザが PC サウンド カードを使用して

サウンドを聞くと、エージェントの通話に著しい遅延が発生します。

ソリューション VoIP モニタリングと録音に関するトラブルシューティング情報について

は、『Configuring and Troubleshooting VoIP Monitoring』を参照してく

ださい。

問題 Supervisor Desktop ウィンドウ内に、所属するチームや他のカスタマイ

ズされた設定が、スーパーバイザに対して表示されません。

ソリューション Supervisor Desktop を [Startup] メニューに追加して、設定ファイルが

ネットワーク上に置かれた場合、PC にはネットワーク ドライブをマッピ

ングする時間がないため、Supervisor Desktop を起動しないと設定ファ

イルがロードされなくなります。その結果、カスタマイズされた設定が表

示されなくなります。
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Supervisor Desktop を閉じて再起動すると、カスタマイズされた設定が

ロードされます。この問題が将来的に発生することを避けるには、

[Startup] メニューから Supervisor Desktop を削除し、プログラムを開

始するために使用するデスクトップ ショートカットを作成します。

問題 スーパーバイザが詳細情報を表示するために [Data View]（または 
[Message View]）ペインをスクロールすると、ツールバーのアイコンが

使用できなくなります。

ソリューション [Team View] ペイン内の任意の場所をクリックすると、ツールバーが再び

使用可能になります。

問題 スーパーバイザがエージェントの会話を録音するために [Record] をク

リックしましたが、何も起こりませんでした。

ソリューション VoIP モニタリングと録音に関するトラブルシューティング情報について

は、『Configuring and Troubleshooting VoIP Monitoring』を参照してく

ださい。

問題 スーパーバイザがエージェント状態を変更しようとしましたが、何も起こ

りませんでした。

ソリューション エージェントの状態を変更する要求が失敗しても、何のメッセージも表示

されません。何も起こらない場合、要求が失敗したと考えてください。

[Team View] ペインに表示される、エージェント名の横のアイコンが現在

のエージェントの状態のアイコンに変化すれば、エージェントの状態が正

しく変更されたことがわかります。

問題 Supervisor Desktop がスキル統計情報を表示しなくなりました。

ソリューション スーパーバイザは、ACD にログインしているエージェントでもあります。

スーパーバイザが非アクティブの状態（「Not Ready」状態）が一定期間

続くと、ACD からログアウトされます。
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スキル統計情報を再び表示するには、スーパーバイザがログインして復帰

する必要があります。このログアウト状況に対する回避策として、スー

パーバイザだけを含み、ACD コールを受信しないスキル グループを作成

する方法があります。これにより、スーパーバイザは自分自身を

「Ready」状態にして必要なだけログインを継続できます。

問題 スーパーバイザが録音をクリックしましたが、再生されません。

ソリューション VoIP モニタリングと録音に関するトラブルシューティング情報について

は、『Configuring and Troubleshooting VoIP Monitoring』を参照してく

ださい。

問題 電話会議の終了後、チャット クライアントと Supervisor Desktop に別の

参加者とのコールが表示されます。

ソリューション 各エージェントは CTI サーバから異なるデータを受信する場合がありま

す。たとえば、お客様（555-5555）がエージェント A にコールします。

すると、CTI サーバは 555-5555 を呼び出し番号としてエージェント A 
に報告します。次に、エージェント A はエージェント B と会議をします。

ただし、この場合の CTI サーバはエージェント B に対し、カスタマー番

号として <Unavailable> と報告します。2 人のエージェント（エージェ

ント A とエージェント B）、カスタマー番号、および <Unavailable> の
データをマージするときに、カスタマー番号と <Unavailable> を識別で

きないため、別の参加者が追加されます。

問題 複数のスーパーバイザがランダムにコール / チャット サービスからログ

アウトしています。

ソリューション スーパーバイザが、別のスーパーバイザと同じ ID でコール / チャット 
サービスにログインしようとすると、コール / チャット サービスは最初

のスーパーバイザをログアウトさせます。この問題を回避するには、各

スーパーバイザが固有の ID を使用するようにしてください。ID は、

Phonedev.ini（config フォルダ内にある）に保存されている内線です。

Phonedev.ini には、Agent Desktop を起動したときの [Login] ダイアロ

グボックスの内線フィールドが入力されます。
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問題 スーパーバイザがエージェントの会話の録音を開始しましたが、すぐに録

音が自動的に停止しました。

ソリューション 他のスーパーバイザが同じエージェントのチームを表示していないことを

確認してください。Supervisor Desktop を使用するすべてのスーパーバ

イザは、録音中のすべての会話を表示でき、エージェントの会話の録音を

（たとえその録音を自分が開始してなくても）停止できます。

問題 スーパーバイザがブラインド会議を表示していますが、コールに参加する

すべての参加者を確認できません。

ソリューション CAD 6.6 ブラインド会議は、アラート参加者を会議に追加する機能として

定義されています。Supervisor Desktop、CAD-BE、または Agent 
Desktop のいずれかで、ブラインド会議に参加するすべての参加者が表

示されない場合があります。これは CTI サービス ソフトウェアの制限事

項です。

問題 エージェントのカスタマー コンタクトをモニタリングしている間は何も

聞こえず、15 秒後に、パケットを一切受信していないことを示すエラー 
メッセージを受信します。エージェントのカスタマー コンタクトを録音

しようとしても、何も録音されません。エージェントのデスクトップは、

デスクトップ モニタリングを使用してモニタされます。

ソリューション CAD で正しく機能するためには、デスクトップ モニタリングで次のデバ

イス設定が必要です。この設定は、Unified CM Administration アプリ

ケーションで設定されます。

（注）すべてのデバイスまたは Unified CM バージョンで次の設定すべて

を使用するわけではありません。ご使用のデバイスおよび Unified CM 
バージョンで表示される設定を設定してください。

[Device Configuration] 画面の [Product Specific Configuration] セク

ションで、これらの設定を次のように設定します。

 [PC Port]：[Enabled]。[PC Port] を有効にしないと、ポートに接続す

るエージェントの PC はネットワークにアクセスしません。デスク

トップ モニタ モジュールからは、音声ストリームは表示されません。

 [PC Voice VLAN Access]：[Enabled]。[PC Voice VLAN Access] を有

効にしないと、デスクトップが同じ VLAN のメンバーでない場合、音

声ストリームがデスクトップに電話として認識されません。
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 [Span to PC Port]：[Enabled]。[Span to PC Port] が有効でないと、

電話によって認識される音声ストリームがデスクトップ モニタ モ
ジュールには認識されません。

[Device Configuration] 画面の [Device Information] セクションで、この

設定を次のようにします。

 [Device Security Mode]：[Non-Secure] または [Authenticated]。
[Device Security Mode] を [Encrypted] に設定すると、音声ストリー

ムは認識されますが、正しく変換されずにスピーチが不明瞭になりま

す。

また、エージェントの電話で G.711 コーデックまたは G.729 コーデック

を使用するように設定する必要があります。これ以外の G.722 などの

コーデックは、サイレント モニタリングおよびサイレント録音をサポー

トしていません。

問題 アップグレード後、Supervisor Desktop の [Preferences] ダイアログ

ボックス内の [Report Font Size] フィールドが空白です。

ソリューション ドロップダウン リストからフォント サイズを選択します。最小レポート 
フォント サイズは 15 です。

問題 スーパーバイザのスクリーン リーダーが、レポート内の表セルの内容を

読み取っていません。

ソリューション 初期状態では、レポート内のテキストをスクリーン リーダーで読み取れ

ない場合があります。スクリーン リーダー プログラムでレポート セルの

テキストを強制読み取りする方法については、スクリーン リーダーのマ

ニュアルを参照してください。

問題 スーパーバイザが CAD エージェントをログアウトさせても、そのエー

ジェントが Supervisor Desktop のエージェント リストにまだ表示されて

います。スーパーバイザが CAD-BE エージェントをログアウトさせると、

そのエージェントは Supervisor Desktop のエージェント リストから消去

されます。

ソリューション これは、CAD-BE の正常な動作です。
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同期サービスに関する問題

問題 同期サービスが正しく実行中されているどうか、どうすれば確認できます

か。

ソリューション Desktop Administrator で、特定の論理コンタクト センターに対して手

動で同期化を実行します。その論理コンタクト センターに、すべての

エージェント、スーパーバイザ、およびチームが正しく示されることを確

認します。

問題 管理者が Desktop Administrator で同期化を実行すると、メッセージ「At 
least one or more errors occurred during synchronization」が表示され

ます。

ソリューション 同期サービスのログ ファイルを確認してください。ログに記録されたエ

ラーが Acmi 接続の問題を示している場合は、CTI サーバの問題を探しま

す。また、Enterprise サーバ ログで類似した問題を探します。ログに記

録されたエラーが LDAP エラーを示している場合は、LDAP サービスが実

行していること、および次のファイル内の LDAP Host 1 レジストリ設定

に正しい値が含まれていることを確認します。HKEY_LOCAL_
MACHINE¥SOFTWARE¥Spanlink¥CAD¥SiteSetup
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Unified CCX ライセンス管理に関する問題

問題 メッセージ「There are no licenses available.Please contact your 
Administrator for help,」が表示されます。

ソリューション すべてのライセンスは現在使用されています。営業担当者に連絡して、追

加ライセンスを入手してください。

問題 リアルタイム レポートにログインしたリソース数は表示されますが、現

在ログインしているスーパーバイザの数が表示されません。現在ログイン

しているスーパーバイザの数は、どうすれば表示できますか。

ソリューション デスクトップ シートを消費しているクライアントまたは CAD 管理アプリ

ケーションを実行しているクライアントの IP アドレスを表示するには、

CAD サーバの Cisco¥Desktop¥bin フォルダの ShowLicenseUsage ユー

ティリティを実行します。

IP Phone Agent および CAD（Browser Edition）シートの場合、IP アド

レスは、アクティブなブラウザおよび IP Phone エージェント（BIPPA）
サービスの IP アドレスであることに注意してください。Web ベースの 
Cisco Desktop Administrator の場合、IP アドレスは CAD サーバの IP ア
ドレスです。
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VoIP モニタに関する問題

問題 VoIP モニタ サービス PC の CPU 使用率が 99% に達したため、PC がロッ

クされました。

ソリューション これは、VoIP モニタ サービスを実行中に Windows の [Network and 
Dialup Connections] ウィンドウでスニファ アダプタを無効にした場合に

発生します。VoIP モニタ サービスの実行中にスニファ アダプタを再度有

効にしても、この問題は解決されません。通常の機能を復元するには、

VoIP モニタ サービスを停止し、スニファ アダプタを再度有効にしてか

ら、VoIP モニタ サービスを再起動する必要があります。

問題 デスクトップ モニタリング、VoIP モニタ サービス、および録音サービス

で生成された音声トラフィックが Quality of Service（QoS; サービス品

質）にタグ付けされていません。

ソリューション デフォルトでは、Windows XP および Windows Server 2000/2003 で 
Winsock QoS は無効であるため、Windows レジストリを通じて有効にす

る必要があります。

次の手順を実行して、Windows XP または Windows Server 2003 で 
VoIP モニタ サービスの QoS 設定を有効にしてください。

Windows XP または Windows Server 2003 を実行している場合は、次の

ようにします。

1. レジストリ エディタで、HKEY_LOCAL_MACHINE 下の 

SYSTEM¥CurrentControlSet¥Services¥TcpIp¥Parameters にアク

セスします。

2. [Edit] > [New] > [DWORD Value] を選択します。

3. エントリ名として DisableUserTOSSetting と入力し、Enter キーを

押します。このエントリを追加すると、値は 0（ゼロ）に設定されま

す。この値を変更しないでください。

4. レジストリ エディタを終了し、コンピュータを再起動します。
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問題 サーバベースのモニタリングの使用中に次の例外が発生して VoIP モニタ 
サービスに障害が発生します。

FATAL FCVMS112 splk_pcap_open_live() failed.errorBuf = Error 
opening adapter: Access is denied.

状況：サーバに 2 番目の NIC がインストールまたは有効にされています。

CAD Configuration Setup を実行して 2 番目の NIC を検出し、VoIP モニ

タ サービスを再起動しています。

ソリューション splkpcap ドライバを再初期化する必要があります。これを実行するには、

ドライバのアンロードとリロードを行います。新しい NIC がインストー

ルされたコンピュータでコマンド ウィンドウを開いて、次のコマンドを

入力します。

net stop spcd 
net start spcd

コマンド ウィンドウを閉じて、CAD Configuration Setup を起動します。

[VoIP Monitor Service] ウィンドウで新しい NIC の IP アドレスを選択し、

変更を保存します。
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